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Introduction

This “Handbook” explains the basic operations and useful 
features of your CLIÉ™ handheld.

When using your CLIÉ handheld for the first time
The basic features and operations are explained in detail
(pages 9-52).

Sony CLIÉ™ handheld basic operations
Explains the basic operations of your CLIÉ handheld and how to use the 
applications.

Entering data on your Sony CLIÉ™ handheld
Explains how to enter data on your CLIÉ handheld.

Exchanging and updating data using the HotSync® operation
Explains how to use your CLIÉ handheld with your computer.

CLIÉ handheld advanced operations
The useful features and how to make full use of your CLIÉ handheld 
are explained in detail (pages 53-165).

Customizing your Sony CLIÉ™ handheld (Preferences)
Explains how to customize your CLIÉ handheld in a way that suits you.

Exchanging and updating data using the HotSync® operation 
(Other HotSync® operations)
Explains the various methods of the HotSync® operations.

Using “Memory Stick®” media
Explains how to use data stored on “Memory Stick” media.

Beaming
Explains how to exchange data with another CLIÉ handheld via beaming.

Using the calculator and finding records
Explains the calculator and how to find records.

Backing up your Sony CLIÉ™ handheld data
Explains how to back up the data of your CLIÉ handheld.

Protecting your data with a password
Explains how to assign a password to restrict the use of your CLIÉ handheld 
or to protect your data.

Enhancing features with add-on applications
Explains how to install additional applications in your CLIÉ handheld.

Transferring data with another Sony CLIÉ™ handheld
Explains how to transfer data from your CLIÉ handheld to another CLIÉ 
handheld.
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Refer to the following together with this manual.

Note
Some of the illustrations in this manual (Handbook) may not be identical to your Sony 
CLIÉ handheld.
bFor details about your CLIÉ handheld, refer to “Read This First (Operating 

Instructions).”

Read This First (Operating Instructions)

Read this manual first.
The manual explains what you need to prepare prior to operating your CLIÉ 
handheld, basic operations, or supplied applications in your CLIÉ handheld.

CLIÉ Application Manual (HTML format: Start up on a computer)

This manual explains how to use the supplied applications in detail.
For details on using the manual, refer to “Using CLIÉ Application Manual” 
in “Read This First (Operating Instructions).”

Troubleshooting Q&A

This manual helps solve problems that you may encounter while using your 
CLIÉ handheld.
3
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Sony CLIÉ™ handheld 
basic operations

This chapter explains the basic operations of your 
CLIÉ handheld, such as using the stylus, using the 
Jog Dial™ navigator, locating the components 
and starting the applications.
The chapter also gives an overview of menus that 
are common to the applications and explains how 
to select the font of characters.

Basic operations . . . . . . . . . . . . . . . . . . . . . .  10
Starting and quitting an application . . . . . . . . .  14
Using the Application Launcher screen . . . . . . . .19
Changing fonts  . . . . . . . . . . . . . . . . . . . . . . .  24
Common menus  . . . . . . . . . . . . . . . . . . . . . .  25
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Basic operations
You can operate your CLIÉ handheld using the stylus and the 
Jog Dial™ navigator.

Using the stylus

Tip

Where is the stylus located?
The stylus is stored in your CLIÉ handheld. 
The storage location varies depending on your model.
bFor details, refer to “Sony CLIÉ™ handheld components” in “Read 

This First (Operating Instructions).”

Note

To avoid losing the stylus, always put it back in the holder of your 
CLIÉ handheld after use.

What is a stylus?
The stylus refers to the “pen” used for 
operating your CLIÉ handheld by directly 
touching the screen.

Continued on next page
• • • • • • • • • • • • • • •
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Basic operations
You can operate your CLIÉ handheld using the stylus in the 
following ways. 

Tapping
Lightly pressing the desired item on the 
screen with the stylus is called “Tapping.” 
When entering data with the on-screen 
keyboard or starting an application, “tap” 
the desired button or icon with the stylus.

Dragging
Touching the desired item on the screen 
with the stylus and moving it along the 
screen surface is called “Dragging.”
Just as you “drag” the mouse on your 
computer, use the stylus to “drag” the 
scroll bar to scroll the screen or “drag” 
characters to highlight them.
Sony CLIÉ™ handheld basic operations 11
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Basic operations
Using the Jog Dial™ navigator

Tip

The icon of any application that supports the Jog 
Dial™ navigator operations is marked with the Jog 
Dial™ navigator  mark*.
For applications not supporting the Jog Dial™ 
navigator operations, you can use the JogAssist 
function to enable the Jog Dial™ navigator 
operations.
* The World Alarm Clock icon, PhotoStand icon 

and CLIE Paint icon do not have the  mark, but support the Jog 
Dial™ navigator operations.

bFor details, refer to “Setting the JogAssist function” on page 72.

What is the Jog Dial™ 
navigator?
Your CLIÉ handheld is equipped with a 
Jog Dial™ navigator, located at the left 
side of your CLIÉ handheld, which enables 
you to perform major operations one-
handed, without the stylus.

 mark

Continued on next page
• • • • • • • • • • • • • • •
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Basic operations
Note

The operations you can perform by using the Jog Dial™ navigator vary 
depending on the application. 
bFor details on the operations of each application, refer to the “CLIÉ 

Application Manual” installed in your computer.

Tip

Rotating while holding down the Jog Dial™ navigator
Some applications support operations executed by pressing and 
rotating the Jog Dial™ navigator. 

Rotating the Jog Dial™ navigator
Rotate the Jog Dial™ navigator to select 
items or to start applications.

Pressing the Jog Dial™ navigator
Press the Jog Dial™ navigator to select an 
item or to run a selected application.
Sony CLIÉ™ handheld basic operations 13
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Starting and quitting an application
Software that you can use on your CLIÉ handheld to execute a 
task, such as Date Book, To Do List or e-mail software, is 
called an “application.” You need to start an application to 
operate your CLIÉ handheld.

Note

bFor details on starting applications in “Memory Stick” media, refer 
to page 112.

There may be some system limitations when you start applications in 
“Memory Stick” media on the Application Launcher screen.

Tip

What is the Application Launcher screen?
The screen displayed by turning on your CLIÉ handheld and tapping 
the Home  icon is called the Application Launcher screen.
Sony CLIÉ™ handheld basic operations 14
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Starting and quitting an application
Starting an application

Starting an application with the Jog Dial™ 
navigator

1 Tap the Home  icon to display the 
Application Launcher screen.

2 Rotate the Jog Dial™ navigator to select an 
application you want to start and press the Jog 
Dial™ navigator.
The application starts.
Sony CLIÉ™ handheld basic operations 15

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Starting and quitting an application
Changing the start-up screen for the Jog 
Dial™ navigator operation
You can set the Jog Dial™ navigator to display a list of 
applications on the left side of the Application Launcher screen 
when you rotate the Jog Dial™ navigator.

1 Tap the Menu  icon on the Application 
Launcher screen.
The menu is displayed.

2 Tap Preferences from the Options menu.
The Preferences dialog box is displayed.

Continued on next page
• • • • • • • • • • • • • • •
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Starting and quitting an application
3 Tap the arrow V next to Jog Select and select 
PopUp.

4 Tap OK.
When the Jog Dial™ navigator is rotated, the list of 
applications are automatically displayed on the left side of 
the Application Launcher screen.

Starting an application by tapping an 
application icon

1 Tap the Home  icon to display the 
Application Launcher screen.

Continued on next page
• • • • • • • • • • • • • • •
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Starting and quitting an application
2 Tap an icon of the application you want to 
start.

Quitting an application
Only one application at a time can be opened and active on your 
CLIÉ handheld.
There is no need to quit the application because the application 
will be closed automatically when you start another application.
The operation to save data is not required when you quit an 
application.
All work done while operating an application will be saved 
automatically when the application is closed. When you restart 
the application, the last-saved data will be displayed 
automatically.

Note

For some applications, you need to quit and save the data of the 
application. 
bFor details, refer to the “CLIÉ Application Manual” installed in your 

computer.

Tip

You can return to the Application Launcher screen by pressing the 
BACK button repeatedly.
Sony CLIÉ™ handheld basic operations 18
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Using the Application Launcher screen
Locating the Application Launcher screen
The screen displayed by turning on your CLIÉ handheld and 
tapping the Home  icon is called the Application Launcher 
screen. You can display applications by category by tapping the 
Home  icon repeatedly. Application icons are displayed by 
default.

Tap to display 
menus.

Tap to select a 
category to be 
displayed.
Sony CLIÉ™ handheld basic operations 19
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Using the Application Launcher screen
Changing the display style of the Application 
Launcher screen 

On the Application Launcher screen, you can display 
applications in the list format or in the small-icon format. You 
can also set to display your favorite category or the last-used 
application when the Application Launcher screen is displayed.
Application icons are displayed by default.

1 Tap the Home  icon.

2 Tap the Menu  icon.

3 Tap Preferences from the Options menu.

4 Tap the arrow V next to View By and select 
List, List (Small) or Icon (Small).

5 Tap OK.

List view List (Small) view Icon (Small) view
Sony CLIÉ™ handheld basic operations 20
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Using the Application Launcher screen
Setting to display the last-opened category 
or the last-used application when the 
Application Launcher screen is displayed

1 Tap the Home  icon.

2 Tap the Menu  icon.

3 Tap Preferences from the Options menu.

4 Tap the Remember Last Category or 
Remember Last Used App check box to 
select.
The check boxes are selected by default.

5 Tap OK.

Note

Applications and categories that are opened by pressing the 
application buttons are not recognized as the last-used 
applications.
Sony CLIÉ™ handheld basic operations 21
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Using the Application Launcher screen
Displaying applications by category
You can choose to display applications by category on the 
Application Launcher screen.

Categorizing applications

1 Tap the Home  icon.

2 Tap the Menu  icon.

3 Tap Category from the App menu.

4 Tap the arrow V next to each application and 
select the category.

Note

To create a new category, tap the arrow V in the upper right corner 
of the Application Launcher screen and then tap Edit 
Categories to open the Edit Categories dialog box.
And tap New, enter a category name, and tap OK. Tap OK again 
when the new category is added.

5 Tap Done.
Sony CLIÉ™ handheld basic operations 22
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Using the Application Launcher screen
Displaying by category

1 Tap the Home  icon.

2 Perform either one of the following operations.
• Repeatedly tap the Home  icon or repeatedly press the 

Jog Dial™ navigator to display applications by category.
• Tap the arrow V in the upper right corner of the 

Application Launcher screen and select a category you 
want to display.

Tip

When you select All, all applications are displayed on the 
Application Launcher screen.
It is useful to select All when you start an application with the Jog 
Dial™ navigator.
Sony CLIÉ™ handheld basic operations 23
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Changing fonts
You can change the font style in applications such as Date 
Book or Address Book according to your preferences. A 
font style can be assigned to each application.

1 Start an application of which you want to 
change the font style.

2 Tap the Menu  icon.
The menu is displayed.

3 Tap Font from the Options menu.
The Select Font dialog box is displayed.

4 Tap the font style you want to use.

5 Tap OK.
The text in the application is displayed in the font style you 
selected.

Note

You may not be able to change the font style depending on 
applications.
Sony CLIÉ™ handheld basic operations 24
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Common menus
The following list describes the functions of each menu that is 
commoxn for your CLIÉ handheld applications such as Date 
Book, Address Book, To Do List, Memo Pad and 
Mail*.
To display the menu, tap the Menu  icon while operating an 
application.
For menus that are specific to an application, refer to the 
descriptions of menus for each application.
*May not be available on all models.

Note

Some menus may not be displayed depending on the display style.

Edit Menu

Undo Reverses the action of the last edit command. 
For example, if you used Cut to remove text, 
Undo restores the text you removed. 

Cut Removes the selected text and stores it 
temporarily in the memory of your CLIÉ 
handheld. You can paste the text you cut into 
a different area of the current application or 
into other applications.

Copy Copies the selected text and stores it 
temporarily in the memory of your CLIÉ 
handheld. You can paste the text that you 
copied into a different area of the current 
application or into other applications.

Paste Inserts the text that you cut or copied at the 
selected point. If you did not previously cut 
or copy text, paste does not work.

Continued on next page
• • • • • • • • • • • • • • •
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Common menus
Select All Selects all of the text in the current record or 
screen. This function enables you to cut or 
copy all of the text and paste it at the selected 
point.

Keyboard Opens the on-screen keyboard. 

Graffiti Help Opens the list of the Graffiti® character 
strokes. You can view a stroke for a character 
as needed.
Sony CLIÉ™ handheld basic operations 26
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Entering data on 
your Sony CLIÉ™ 
handheld

This chapter explains how to enter data on your 
CLIÉ handheld.

Entering data on your Sony CLIÉ™ handheld . . .  28
Practicing entering data using the on-screen 

keyboard  . . . . . . . . . . . . . . . . . . . . . . . .  29
Using Graffiti® writing to enter data. . . . . . . . .  32
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Entering data on your Sony CLIÉ™ 
handheld
On-screen keyboard (Input 
panel) (page 29)
Enter data by tapping the keyboard 
displayed on the screen.

Graffiti® (page 32)
Enter data using the freehand input 
characters called Graffiti. Once you 
get used to entering data using 
Graffiti, it is much faster than 
entering data with the on-screen 
keyboard.
Entering data on your Sony CLIÉ™ handheld 28
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Practicing entering data using the on-
screen keyboard
You can enter data using the stylus of your CLIÉ handheld.

Entering data
To enter data, software (an application) that is compatible with 
your CLIÉ handheld is required. Follow the steps below to 
practice entering data using Date Book.

1 Tap [Date Book] icon on the Application 
Launcher screen.
Date Book starts up. Today's schedule is displayed.

2 Tap the time line on the Date Book screen.

Continued on next page
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Practicing entering data using the on-screen keyboard
3 Tap “a” to open the alphabetic keyboard, or 
tap “1” to open the numeric keyboard.
The selected keyboard is displayed.

4 Select the desired keyboard and tap the 
characters to enter text and numbers.
You can use the on-screen keyboard in the same way as in 
the keyboard of your computer. To enter a capital letter, tap 
cap and then tap the character button. To delete a character, 
tap  <.

Tap here for the  
alphabetic 
keyboard

Tap here for the 
numeric keyboard

Alphabetic
Tab

Caps lock

Caps shift

Back Space

Carriage return

Tap here to display alphabetic keyboard

Numeric International

Tap here to display the 
numeric keyboard

Tap here to display the 
international keyboard

Continued on next page
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Practicing entering data using the on-screen keyboard
5 After you finish entering data, tap Done to 
close the on-screen keyboard and the text is 
placed in the record.
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Using Graffiti® writing to enter data
This section describes the procedure for creating letters, 
numbers, punctuations and symbols by Graffiti® writing, and 
teaches you some Graffiti® tips and tricks.

What is Graffiti® writing?
Most people find that they can enter text quickly and accurately 
with only minutes of practice. Graffiti writing includes any 
character you can type on a standard keyboard. The Graffiti 
strokes closely resemble the upper case letters of the regular 
alphabet, which makes Graffiti writing easy to learn.

Entering characters with a single stroke
Most characters require only a single stroke. When you lift the 
stylus from the Graffiti writing area, your CLIÉ handheld 
recognizes and displays the text character immediately. 
To allow you to write an entire character with a single stroke, 
some Graffiti strokes are portions of the regular alphabet.

The dot on each shape shows where to begin the 
stroke
Certain characters have similar shapes, but different beginnings 
and end points. Always begin the stroke from the dot.

Note

You do not need to create the dot; it is only there to show you where to 
begin the stroke.

(Graffiti writing examples 
A, B, C, D, E)

Begin the stroke from dot

Lift the stylus here
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Using Graffiti® writing to enter data
The area for writing characters and numbers are 
different
The Graffiti writing area is divided into two parts: the left side of 
the Graffiti writing area is for writing the characters and the right 
side for writing numbers. The small marks at the top and bottom 
of the Graffiti writing area separate the two areas.

Graffiti character list

Alphabet

A J

B K

C L

D M

E N

F O

G P

H Q

I R

Write characters 
here

Write numbers 
here

Division marks

Continued on next page
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Using Graffiti® writing to enter data
Numbers

Keyboard symbols

S W

T X

U Y

V Z

0 5

1 6

2 7

3 8

4 9

Space Period Tap twice

Back Space Caps Shift

Carriage 
Return

Caps Lock
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Using Graffiti® writing to enter data
Writing capital letters
Shift to caps to write capital letters with the same stroke shapes 
as the basic alphabet letters.

• To write the first letter of a word as a capital letter
Use the Caps Shift stroke  .

To return to lower case letters, use the BackSpace stroke  .

Note

When you create a new sentence or a new record (by tapping New 
or a blank line), the first letter is automatically capitalized.

• To enter only capital letters (Caps Lock)
Use the Caps Lock stroke  .

To return to lower case letters, use the Caps Shift stroke  .

Writing punctuation marks
Tap once on the Graffiti writing area to activate the Punctuation 
Shift. The next stroke you draw anywhere in the Graffiti area 
(the characters or numbers side) creates a punctuation mark.

Caps Shift

Caps Lock

Punctuation Shift

Continued on next page
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Using Graffiti® writing to enter data
To undo punctuation shift
Draw  (Back Space). 

(.) Period (—) Dash

(,) Comma ( ( ) Left Paren

(’) Apostrophe ( ) ) Right Paren

(?) Question (/) Slash

(!) Exclamation ($) Dollar

(@) At (\) Back slash

(#) Number ({) Left brace

(%) Percent (}) Right brace

(^) Circumflex ([) Left square 
bracket

(&) Ampersand (]) Right square 
bracket

(*) Asterisk (-) Swung dash

(<) Left angle 
bracket

(\) Grave accent

(>) Right angle 
bracket

(;) Semicolon

(_) Under bar (:) Colon

(" ) Ditto Tab
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Using Graffiti® writing to enter data
Writing symbols and extended characters
Make the Symbol Shift stroke   on the Graffiti writing area to 
activate the Symbol Shift. The next stroke you draw creates a 
symbol or extended character.

To undo symbol shift mode
Draw  (Back Space).

(•) Bullet x

(™) Trademark ÷

(®) Registered =

(©) Copyrighted (¢) Cent

(‘) Left single 
quotation mark

(¥) Yen

(’) Right single 
quotation mark

(£) Pound

(“) Left double 
quotation mark

( ) Euro

(”) Right double 
quotation mark

¿

(§) Section ¡

(°) Degree ß

+ µ

– ƒ

ø

Symbol Shift
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Using Graffiti® writing to enter data
Writing accented characters and non- 
English characters
To write accented characters, draw the stroke normally used to 
write the letter, followed by an accent stroke. Graffiti writing 
then adds the accent to the letter.
To write "é," for example, draw   and then .

To write non-English characters
You can write the following characters without any special 
punctuation or shifting.

Note

You must write these non-English characters on the left side of 
the Graffiti writing area.

à è ì ò ù á é í ó ú ý

â ê î ô û ã õ ñ

ä ï ö ü ÿ å

ç æ
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Using Graffiti® writing to enter data
Displaying the Graffiti Help
Drag the stylus from the bottom of the Graffiti writing area to the 
top of the screen. The Graffiti Help opens a series of screens that 
show the complete Graffiti character set.
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Using Graffiti® writing to enter data
Entering characters with Graffiti® Writing

1 Tap [Date Book] icon on the Application 
Launcher screen.
Date Book starts and today's schedule is displayed.

2 Tap the time line on the Date Book screen.

3 Use the tables on the previous pages to find the 
stroke shape for a letter you want to write.
There are two different stroke shapes available for some 
letters. For those letters, choose the one that is easier for you.
You can use the same strokes to write both the upper case 
and lower case letters.

4 Position the stylus in the left side of the Graffiti 
writing area. Begin your stroke at the dot and 
draw the stroke shape as it appears in the 
tables.

Position the stylus

Continued on next page
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Using Graffiti® writing to enter data
5 Lift the stylus from the screen at the end of the 
stroke shape.
When you lift the stylus from the screen, your CLIÉ 
handheld recognizes your stroke immediately and prints the 
character at the insertion point on the screen.
As soon as you lift the stylus from the screen, you can begin 
another stroke for the next character you want to write.

Note

You must begin the character strokes in the Graffiti writing area. If 
you do not draw Graffiti strokes in the Graffiti writing area, your 
CLIÉ handheld does not recognize them as characters.

Notes on entering Graffiti® writing
• Recognition accuracy improves when you draw your strokes 

that nearly fill in the Graffiti writing area.
• Draw your strokes at natural speed. Drawing too slowly may 

generate recognition errors.
• Do not draw your strokes on a slant. Vertical strokes should be 

parallel to the vertical lines of the Graffiti writing area.
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Using Graffiti® writing to enter data
Using Navigation strokes and shortcuts
You can navigate operations within the fields of your 
applications, such as moving the cursor or quickly entering 
frequently-used symbols, by using the navigation strokes and 
shortcuts of Graffiti writing.

Using Navigation strokes

Move cursor to right

Move cursor to left

You can copy or delete data
(The options you can select vary depending 
on the screen you select.)

Go to the previous field (Address Book only)

Go to the next field (Address Book only)

Open Address Record (Address Book only)
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Using Graffiti® writing to enter data
Using Shortcuts
There are four types of Graffiti Shortcut.
To use a Shortcut, draw the Shortcut stroke   followed by the 
registered Shortcut characters.
When you draw the Shortcut stroke, the Shortcut symbol appears 
at the insertion point to show that you are in Shortcut mode.

The following are Graffiti Shortcuts that are registered on your 
CLIÉ handheld:

For example, when you enter “dts” using the Graffiti Shortcut, 
you can enter the current date and time.

Tip

You can also create your own Shortcuts (page 84).

Date stamp ds Breakfast br

Time stamp ts Lunch lu

Date/time stamps dts Dinner di

Meeting me

b b b
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Exchanging and 
updating data using 
the HotSync® 
operation

This chapter explains how to perform the 
HotSync® operation with your computer.

What is the HotSync® operation?. . . . . . . . . . .  45
Performing the HotSync® operation . . . . . . . . .  47
Using the Palm™ Desktop for CLIÉ software  . . .  49
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What is the HotSync® operation?
The HotSync® operation is a one-step operation that enables you 
to synchronize data between your CLIÉ handheld and your 
computer. With just one press on the HotSync button, you can 
synchronize data on your CLIÉ handheld with data on the 
Palm™ Desktop for CLIÉ software of your computer, back up 
data on your CLIÉ handheld to your computer, and install add-
on applications.

1 Synchronizing data between your CLIÉ 
handheld and your computer
Synchronizes the data of Date Book, Address 
Book, To Do List and Memo Pad between your 
CLIÉ handheld and your computer. You can manage the 
data of multiple CLIÉ handhelds separately using the 
Palm™ Desktop for CLIÉ software.

2 Saving backup data to your computer
Automatically makes backup data on your CLIÉ 
handheld to your computer. If you delete data by 
accident, if data is deleted by a sudden battery shut-off, 
or if you need to perform a hard reset, the HotSync® 
operation allows you to restore the data saved on your 
computer.
bFor details on backing up data, refer to page 142.

Continued on next page
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What is the HotSync® operation?
Tip

You can also back up data on your CLIÉ handheld to 
“Memory Stick” media.
bFor details, refer to “Backing up data to “Memory Stick” 

media using Memory Stick Backup” (page 143).

3 Using data created in Microsoft® Windows® 
applications on your CLIÉ handheld 
Imports or exports data between a Windows application 
in your computer and your CLIÉ handheld.

The compatible file formats that you can import/
export with the Palm™ Desktop for CLIÉ software
• Comma/Tab delimited (*.csv, *.tab, *.tsv, *.txt)
• Text file (*.txt)
• vCal (Date Book) file (*.vcs)
• vCard (Address Book) file (*.vcf)
• Date Book archive of the Palm™ Desktop for CLIÉ software 

(*.dba)
• Address Book archive of the Palm™ Desktop for CLIÉ 

software (*.aba)
• To Do List archive of the Palm™ Desktop for CLIÉ software 

(*.tda)
• Memo Pad archive of the Palm™ Desktop for CLIÉ software 

(*.mpa)

* The words in the parentheses are file extensions. Archive is a unit 
that gathers associated files.

bFor details on importing/exporting data, refer to the Help menu of 
Palm™ Desktop for CLIÉ software.
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Performing the HotSync® operation
This section explains how to perform the HotSync® operation 
assuming that you have performed all the necessary preparations 
and installations for your CLIÉ handheld and your computer. 
bFor details on how to prepare for the HotSync® operation, follow the 

procedure in “Setting up your Sony CLIÉ™ handheld” in “Read This 
First (Operating Instructions).”

Performing the HotSync® operation with the USB 
cable (Local HotSync®)

Performing the HotSync® operation with the USB cable and 
plug adapter is called a Local HotSync®.

1 Connect your CLIÉ handheld to your computer 
with the USB cable.

2 Rotate the Jog Dial™ navigator to select 
[HotSync] icon on the Application Launcher 
screen and press the Jog Dial™ navigator.
The HotSync® operation starts.

Tip

You can also tap [HotSync] icon to start the HotSync® operation.

3 Tap the HotSync  icon on the HotSync 
screen.
The HotSync® operation starts.

When the HotSync® operation is complete, the message 
showing the HotSync® completion is displayed on your 
CLIÉ handheld.

Continued on next page
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Performing the HotSync® operation
Note

Do not remove the USB cable from your CLIÉ handheld until the 
HotSync® operation is complete as the Palm™ Desktop for CLIÉ 
software may not close normally.

If the HotSync® operation does not start 
when you tap the HotSync® icon
Make sure that the HotSync  icon is displayed in the 
Windows task tray.
If the HotSync  icon is not displayed in the task tray, click 
Start, then select Programs (All Programs in Windows® 
XP), Sony Handheld and HotSync Manager. Check that 
the HotSync  icon is displayed in the task tray and tap the 
HotSync  icon on the HotSync screen to start the HotSync® 
operation.
The message is displayed on your computer screen when the 
HotSync® operation starts.

* From this point onwards, where Windows XP Home Edition and 
Windows XP Professional are common, they will both be referred to 
as Windows XP.

Notes

• Do not tap the HotSync  icon during the HotSync® operation as 
it may cause errors and the operation may quit.

• Do not enter the power saving mode during the HotSync® operation. 
If your computer is turned to the power saving mode during the 
HotSync® operation, HotSync Manger will be forced to quit.

Tip

If you cannot perform the HotSync® operation
Refer to “Troubleshooting Q&A.”
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Using the Palm™ Desktop for CLIÉ 
software
The Palm™ Desktop for CLIÉ software enables you to view the 
data, which is transferred from your CLIÉ handheld by the 
HotSync® operation, on your computer. 
Additionally, the Palm™ Desktop for CLIÉ software has the 
same functions as Date Book, Address Book, To Do List 
and Memo Pad so that you can enter or modify schedules or 
address data on your computer and export data to your CLIÉ 
handheld.

Starting the Palm™ Desktop for CLIÉ software

1 Double-click [Palm Desktop for CLIÉ] icon on 
the Windows desktop.
Or click Start, then select Programs (All Programs in 
Windows XP), Sony Handheld and Palm Desktop 
for CLIÉ.
The Palm™ Desktop for CLIÉ software starts.

Tip

To quit the Palm™ Desktop for CLIÉ software
Click the close  button in the upper right corner of the screen or 
click Exit from the File menu.
Exchanging and updating data using the HotSync® operation 49

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Using the Palm™ Desktop for CLIÉ software
Locating the Palm™ Desktop for CLIÉ software 
components

A List pane
Displays the records in the current Desktop application.

B Application Launch bar
Click an icon to open the associated application.

C Install Tool icon
Click this icon to display the Install Tool window. You 
can install applications in your CLIÉ handheld with the 
HotSync® operation. 
bFor details, refer to “Installing add-on applications” on page 157.

D User selector
Displays the user name of the current information.

Continued on next page
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Using the Palm™ Desktop for CLIÉ software
E Record pane
Displays full details of the record that is selected in the List 
pane. The information displayed here is the same as that 
displayed on your CLIÉ handheld’s Details screen.

Basic operations of the Palm™ Desktop for CLIÉ 
software

Click an icon of the application you want to use. The screen 
switches to the selected application screen.
Basic operations of each application are the same as those of the 
corresponding your CLIÉ handheld application.
bFor details about operations, refer to the Palm™ Desktop online 

help. To display the online help, select Palm™ Desktop Help 
from the Help menu.

Tip

Changing the user name of your CLIÉ handheld
1 In the Palm™ Desktop for CLIÉ screen, click 

Users from the Tools menu.
The Users window is displayed.

2 Click a user name you want to change and click 
Rename.

3 Enter a new user name and click OK.
Your CLIÉ handheld user name is changed at the next 
HotSync® operation.

Continued on next page
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Using the Palm™ Desktop for CLIÉ software
When using the Microsoft® Windows® XP operating 
system
When you start Palm™ Desktop for CLIÉ software in your 
computer and select Custom, File Link, View Log or Setup 
from the HotSync Manager shortcut menu, the configuration 
window may open behind the Palm™ Desktop for CLIÉ software 
window.
In this case, bring the configuration window to the front by 
performing one of the following.
– Press the Alt and Tab keys at the same time.
– Click the HotSync   icon in the Windows task tray.
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Customizing your 
Sony CLIÉ™ handheld 
(Preferences)

This chapter explains how to customize your CLIÉ handheld 
by changing the Preferences settings.

What you can do with Preferences . . . . . . . . . .  54
Assigning applications to the application 

buttons. . . . . . . . . . . . . . . . . . . . . . . . . .  56
Customizing the full-screen pen stroke 

activities  . . . . . . . . . . . . . . . . . . . . . . . .  57
Assigning applications to the HotSync buttons . .  58
Adding/Changing the modem preferences . . . . .  59
Setting the Date & Time preferences  . . . . . . . .  61
Adjusting the Digitizer  . . . . . . . . . . . . . . . . . .  64
Setting the display format of the time, date and 

numbers. . . . . . . . . . . . . . . . . . . . . . . . .  65
Setting the automatic power-off time . . . . . . . .  67
Setting sounds  . . . . . . . . . . . . . . . . . . . . . . .  68
Turning the Alarm LED on or off. . . . . . . . . . . .  69
Turning the Beam Receive on or off . . . . . . . . .  70
Setting the High Resolution Assist function . . . .  71
Setting the JogAssist function . . . . . . . . . . . . .  72
Changing the Network preferences. . . . . . . . . .  74
Creating Graffiti® ShortCuts  . . . . . . . . . . . . . .  84
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What you can do with Preferences
The Preferences screen enables you to customize the configuration options 
on your CLIÉ handheld.
Setting options may be added by installing new applications or software for 
peripheral devices.

Tip
For the setting options not mentioned in the list, refer to “Read This First (Operating 
Instructions).”

Settings Details

Buttons Customizes applications assigned to the application 
buttons and the HotSync button, or the full-screen pen 
stroke activities.
b For details, refer to page 56~58.

Connection Sets the configuration for the communication device.
b For details, refer to page 59.

Date & Time Sets the current date, time, time zone and daylight saving 
configurations.
b For details, refer to page 61.

Digitizer Calibrates the screen of your CLIÉ handheld.
b For details, refer to page 64.

Formats Sets the formats for time or date.
b For details, refer to page 65.

General Sets the general configuration such as system sound, 
LED feature* or auto shut-off interval.
*May not be available on all models.
b For details, refer to page 67~70.

HiRes Sets the High Resolution Assist function.
b For details, refer to page 71.

Jog Enables or disables the JogAssist function.
b For details, refer to page 72.

Network Sets the Internet connection configuration.
b For details, refer to page 74.

Owner Sets the owner information such as name or phone 
number.
b For details, refer to page 147.

ShortCuts Defines a list of Graffiti® abbreviations.
bFor details, refer to page 84.

Web Clipping* Configures the Internet connection and proxy server 
settings.
*May not be available on all models.
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What you can do with Preferences
Displaying the Preference screen for each menu

1 Rotate the Jog Dial™ navigator to select [Prefs] icon on the 
Application Launcher screen and press the Jog Dial™ 
navigator.
The Preferences screen is displayed.

Tip
You can also tap [Prefs] icon to display the Preferences screen. 

2 Tap the arrow V in the upper right corner of the screen and 
select a Preferences menu you want to configure.
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Assigning applications to the application 
buttons
You can assign your favorite applications to the application buttons on your 
CLIÉ handheld.

For example, you can assign the To Do List button to start Calculator.

The position of the application buttons varies depending on your model.
b For details, refer to “Sony CLIÉ™ handheld components” in “Read This First 

(Operating Instructions).”

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Buttons. 
 The Buttons Preferences screen is displayed.

2 Tap the arrow V next to the icon and select an application 
you want to assign. 
The application button is changed to what you assigned.

To start the original applications
If you have assigned other applications to the buttons, you can start the original 
applications from the Application Launcher screen.

To reset to default settings
Tap Default in step 2. 

All application buttons are reset to default.

(Default screen)
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Customizing the full-screen pen stroke 
activities
You can customize the assignment of the full-screen pen stroke.

By default, the full-screen pen stroke activates the Graffiti® Help.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Buttons.
The Buttons Preferences screen is displayed.

2 Tap Pen.
The Pen dialog box is displayed.

3 Tap the arrow V next to Graffiti Help and select a setting for 
the full-screen pen stroke.

4 Tap OK.

Backlight Turns on the backlight of your CLIÉ handheld without 
using the POWER button.

Brightness Opens the Adjust Brightness dialog box.

Keyboard Opens the on-screen keyboard for entering text.

Graffiti Help Opens a series of screens that show the complete Graffiti 
character set.

Turn Off & Lock Turns off and locks your CLIÉ handheld. To start your 
CLIÉ handheld operation when it is locked, you need to 
enter the password. (To use the Lock function, you need 
to enter a password)
b For details, refer to “Protecting your data with a 

password” (page 146).

Beam Data Beams the current record to another Palm OS PDA.

Drag the stylus from the bottom 
of the Graffiti writing area to the 
top of the screen.
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Assigning applications to the HotSync buttons
You can assign your favorite applications to the HotSync buttons on the cradle 
(sold separately) and modem (if a HotSync button is provided).

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Buttons.
The Buttons Preferences screen is displayed.

2 Tap HotSync.

3 Tap the arrow V next to HotSync and select an application 
you want to assign.

4 Tap OK.
The Buttons Preferences screen is displayed.
You can start the selected application by pressing the HotSync button.
Customizing your Sony CLIÉ™ handheld (Preferences) 58

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Adding/Changing the modem preferences
You can customize the preference for a modem to be connected to your CLIÉ 
handheld. The applications using the modem comply with this preference.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Connection.
The Connection Preferences screen is displayed.

2 Tap New.
To change the existing preference, tap the preference you want to change 
and Edit.

3 Enter the connection name in Name.
Enter a recognizable name.

4 Tap the arrow V next to Connect to and select how you  
connect your CLIÉ handheld to your computer.

5 Tap the arrow V next to Via and select what you use to 
connect your CLIÉ handheld to your computer.

When you select a modem for Connect to

1 Tap the arrow V next to Dialing and select the type of line you want 
to use.
Usually, select TouchTone™.
Do not select Rotary, except when you are sure that the telephone 
service being used is not TouchTone™. 

2 Tap the arrow V next to Volume and select the volume level of the 
modem speaker at the time of connection.

3 Tap Details.

4 Tap the arrow V next to Speed and select the maximum speed for the 
transmission between the modem and your CLIÉ handheld.

5 Tap the arrow V next to Flow Ctl and select the flow control of the 
modem connection. 
Usually, select Automatic.

Continued on next page
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Adding/Changing the modem preferences
6 Enter the modem initialization command in the Init String.
By default, it is set to either AT&FX4 or ATZ. The modem 
initialization command is not required to be changed unless it is 
specified on the modem.

7 Tap OK.

6 Tap OK.
The configuration for the modem is changed and the Preferences screen  
is displayed.
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Setting the Date & Time preferences
You can set the date, time, time zone and the on/off of daylight savings for your 
CLIÉ handheld. After you set the local date and time of your home base, you 
can change the displayed time (for example, during business trips) simply by 
switching the time zones.

Setting the date

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap Set Date box.
The Set Date screen is displayed.

3 Tap the each arrow b or B next to the year at the top of the 
screen to set the year.

4 Tap the current month.

5 Tap the current date.
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Setting the Date & Time preferences
Setting the time

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap Set Time box.
The Set Time dialog box is displayed.

3 Tap the arrow V or v to set the hour.

4 Tap the each minute box and tap the arrow V or v to set the 
minute.

5 Tap AM or PM.

6 Tap OK.
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Setting the Date & Time preferences
Setting the time zone and daylight saving time

Setting the time zone

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap the Set Time Zone field.
The Set Time Zone screen is displayed.

3 Select the time zone of your region.

4 Tap OK.

Setting the daylight saving time

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Date & Time.
The Date & Time Preferences screen is displayed.

2 Tap the arrow V next to Daylight saving.

3 Tap On or Off.
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Adjusting the Digitizer
You need to adjust the digitizer when you performed a hard reset, when the 
tapping operation or scrolling does not work properly, or when you cannot 
adjust the brightness of the back light or screen contrast.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Digitizer.
The Digitizer calibration screen is displayed.

This Digitizer calibration screen is exactly the same as the screen 
displayed for the first time you turn on your CLIÉ handheld. Follow the 
on-screen instructions to adjust the digitizer.

Tip
Use the stylus perpendicular to the screen to tap targets.
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Setting the display format of the time, date 
and numbers
Selecting a regional default
When you select a region where you use your CLIÉ handheld, the display 
format of the time, date, week start day, and numbers are adjusted to the 
regional default. For example, in the United Kingdom, time is expressed using 
a 24-hour clock; in the United States, time is expressed using a 12-hour clock 
with an AM or PM suffix.

The regional default is applied to the display formats of all your CLIÉ handheld 
applications. However, you can customize your own settings for each unit such 
as time or date.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Formats.
The Formats Preferences screen is displayed.

2 Tap the arrow V next to Preset to and select a region name.
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Setting the display format of the time, date and numbers
Customizing your own settings for each unit
You can customize your own settings for the display formats of the time, date, 
week start day, and numbers. The settings are applied to the display formats of 
all your CLIÉ handheld applications. 

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Formats.
The Formats Preferences screen is displayed.

2 Tap the arrow V next to Time and select a desired format.

3 Tap the arrow V next to Date and select a desired format.

4 Tap the arrow V next to Week starts and select Sunday or 
Monday.
This setting is applied to the Day, Week, Month, and Agenda views in 
Date Book and all other applications displaying calendars.

5 Tap the arrow V next to Numbers and select a desired 
format.
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Setting the automatic power-off time
Your CLIÉ handheld has an automatic power-off feature that turns off your 
CLIÉ handheld after a period of inactivity to conserve your CLIÉ handheld 
battery. 

You can adjust the time setting for the automatic power-off function.

By default, your CLIÉ handheld will turn off after two minutes of inactivity 
and will be on while it is connected to the USB cable.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to Auto-off After and select a desired 
time.
You can select 30 seconds, 1 minute, 2 minutes or 3 minutes.

3 If you want to leave your CLIÉ handheld turned on while it is 
connected to the AC power adapter or cradle (sold 
separately), tap the Stay on in Cradle check box to select.
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Setting sounds
You can adjust the volume level of the system sounds, alarm sounds and game 
sounds, or turn the sounds off completely.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to System Sound and select a desired 
volume level or Off.
When the System Sound is turned off, the chime tones associated with the 
HotSync® operation are also turned off.

3 Tap the arrow V next to Alarm Sound and select a desired 
volume level or Off.

4 Tap the arrow V next to Game Sound and select a desired 
volume level or Off.
The Game Sound setting is only applied to the games programmed to 
respond to this setting.
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Turning the Alarm LED on or off
You can set the CLIÉ handheld to flash its LED at the desired time. If you turn 
off the Alarm Sound function and turn on the Alarm LED function, you can use 
the alarm feature without disturbing other people around you.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to Alarm LED and select On or Off.
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Turning the Beam Receive on or off
Your CLIÉ handheld has a Beam Receive feature that you can turn on and off. 

When you turn off the Beam Receive function, you cannot receive data via 
beaming but your CLIÉ handheld battery is conserved. By default, the Beam 
Receive function is set to On.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select General.
The General Preferences screen is displayed.

2 Tap the arrow V next to Beam Receive and select On or 
Off.
• On: Enables the Beam Receive function.
• Off: Disables the Beam Receive function.
Customizing your Sony CLIÉ™ handheld (Preferences) 70

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Setting the High Resolution Assist function
You can use the High Resolution Assist function to enable the high resolution 
display of an application that even does not support the high resolution mode. By 
default, the High Resolution Assist function is not set. 

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select HiRes.
The HiRes Preferences screen is displayed.

2 Tap the Enable High Resolution Assist check box to 
select.
The confirmation dialog box is displayed.

3 Tap OK.
The HiRes preferences screen is displayed.

4 Tap an application(s) that you do not want to display in the 
high resolution mode in the list box.

Note
Quit the High Resolution Assist function if the following occurs.
• Performances are largely deteriorated (e.g. game).
• Display is divided into two, characters are distorted, or other operational 

irregularities occur.
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Setting the JogAssist function
You can set the Jog Dial™ navigator to operate third-party applications that are 
not designed to use the Jog Dial™ navigator operations. The JogAssist 
function enables you to perform the following operations.

• You can scroll the screen with the Jog Dial™ navigator.

• You can select an item from the PopUp list with the Jog Dial™ navigator.

• You can move back and forth between screens with the BACK button.

You can also set the BACK button to turn on or off your CLIÉ handheld when 
the BACK button is kept pressed.

Notes
• The operations activated by the JogAssist function may differ depending on the 

application you use.
• In some applications with the Jog Dial™ navigator mark, part of operations may differ 

when the JogAssist function is activated and not activated.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Jog.
The Jog Preferences screen is displayed.

2 Tap the Use JogAssist check box to clear the selection 
when you do not want to use the JogAssist function.

3 To set to turn on your CLIÉ handheld by keeping the BACK 
button pressed, tap the Power On with BACK button check 
box to select.
You need to keep the BACK button pressed for several seconds to turn on 
your CLIÉ handheld.

Continued on next page
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Setting the JogAssist function
4 To set to turn off your CLIÉ handheld by keeping the BACK 
button pressed, tap the Power Off check box to select.
The Jog Dial™ navigator settings are changed.

Tip
By default, the selections of Use JogAssist and Display Cursor/Menu are 
selected, and Power On with BACK button and Power Off are not selected.
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Changing the Network preferences
Note
For the settings specific to each peripheral device, refer to the manual of each peripheral 
device.

Selecting a service template
You can customize the Service setting to select the service template for your 
Internet Service Provider or a dial-in server. 

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select Network.
The Network Preferences screen is displayed.

2 Tap the arrow V next to Service and select the service 
template (Internet Service Provider name) you want to use.

Tips
• To add a new service template, select New from the Service menu.

If the Internet Service Provider name you want to use is not displayed in the list, 
tap the area showing the service template, or select New from the Service 
menu, and enter the new Internet Service Provider name.
You can create multiple service templates for your Internet Service Provider. 
You need to name them so that those service templates are uniquely identified, 
such as “So-net1” and “So-net2.” It is useful for creative use of your Internet 
Service Provider by access point or setting.

• When you want to copy an existing service template without changing, select 
Duplicate from the Service menu.
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Changing the Network preferences
Entering a user name
The User Name setting identifies a name you use when you log into your 
Internet Service Provider or dial-in server.

1 On the Network Preferences screen, tap User Name field.

2 Enter your user name.

Notes
• Although this field can contain multiple lines of text, only two lines appear on 

the screen.
• Most dial-in servers do not accept spaces in the user name.

Entering a password
The Password box identifies a password you use to log into your server or ISP. 
Your entry in this field determines whether your CLIÉ handheld prompts you 
to enter a password each time you log into your network:

• If you do not enter a password, your CLIÉ handheld displays the word 
-Prompt- in this field and asks you to enter a password during the log-in 
procedure.

• If you enter a password, your CLIÉ handheld displays the word 
-Assigned- in this field and does not prompt you to enter a password during 
the log-in procedure.

Note
If you are concerned about security, select the Prompt option and do not enter a 
password.

1 On the Network Preferences screen, tap the Password 
field.

2 Enter a password you use to log into your server.

3 Tap OK.
The Password field updates to display the word -Assigned-.
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Changing the Network preferences
Selecting a connection
Use the Connection setting to select a method you want to use to connect to 
your Internet Service Provider or a dial-in server.

1 On the Network Preferences screen, tap the arrow V next 
to Connection and select Standard Modem.

Adding telephone settings
When you select the Phone field, your CLIÉ handheld opens a screen in 
which you define the telephone number you use to connect with your ISP or 
dial-in server. In addition, you can also define a prefix, disable Call Waiting, 
and give special instructions for using a calling card.

Note

The Phone Setup screen works correctly for AT&T and Sprint long- distance 
services. However, because MCI works differently, MCI customers need to put 
the calling card number in the Phone # field and the phone number in the Use 
calling card field.

1 On the Network Preferences screen, tap the Phone field.
The Phone Setup screen is displayed.

2 Enter the phone number for your ISP or dial-in server in the 
Phone # field.

3 Change the following settings if necessary:
1 Enter the telephone number used to access the modem.

If necessary, enter a dial prefix (such as “9”) to access an outside line, 
and select the Dial prefix check box. You can enter a comma in the 
field to introduce a “pause” in the dialing sequence. Each comma 
equals a two second pause.

2 If the phone line you are using for your CLIÉ handheld has Call 
Waiting, select the Disable call waiting check box to avoid an 
interruption during the modem HotSync® operation.

Continued on next page
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Changing the Network preferences
Note
Each telephone company assigns a code to disable Call Waiting. Contact your 
local telephone company for the code that you need.

3 If you want to use a calling card to place the call, select the Use 
calling card check box and enter the calling card number.

Tip
There is usually a delay before you enter your calling card number.
Consequently, add at least three commas before your calling card number to 
compensate for the delay.

4 Tap OK.

Adding detailed information to a service template
When you are using one of the predefined service templates, you probably need 
to enter your user name and telephone number only. When you are creating a 
new service template, you may need to provide additional information to your 
ISP or dial-in server. Use the Details screen to add additional information to 
a selected service template.

To select a connection type

1 On the Network Preferences screen, tap Details.
The Details screen is displayed.

2 Tap the arrow V next to Connection type and select one of 
the following connection types.
• PPP: Point-to-Point Protocol
• SLIP: Serial Line Internet Protocol
• CSLIP: Compressed Serial Line Internet Protocol

Tip
If you are not sure, try PPP; if that does not work, ask your Internet Service Provider 
or your System Administrator for the correct connection type.

Continued on next page
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Changing the Network preferences
3 Tap the arrow V next to Idle timeout and select one of the 
following options.
• 1 Minute: Waits one minute before dropping the connection when you open 

another application that does not use the network. 1 Minute is assigned by 
default.

• 2 Minutes: Waits two minutes.
• 3 Minutes: Waits three minutes.
• Never: Keeps your PPP or SLIP connection until you turn off your CLIÉ 

handheld.
Note that this option will be more costly than others.

4 Tap the Query DNS check box to clear.

5 Enter the IP address for the Primary and Secondary DNS 
(Domain Naming System).
Ask your Internet Service Provider or System Administrator for the 
correct Primary or Secondary DNS IP numbers.

6 If you need to enter the IP address for your CLIÉ handheld, 
tap the IP Address check box to clear the selection and 
display a permanent IP address field below the check box.
Normally, you do not have to enter this IP address. If you are not sure, 
select Automatic and go to step 8.

7 Enter the IP address for your CLIÉ handheld.
Ask your Internet Service Provider or System Administrator for the 
correct IP address.

8 Tap OK.
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Changing the Network preferences
Creating additional service templates
You can create additional service templates from scratch or by duplicating 
existing templates and editing the information. After you create a new or 
duplicate template, you can add and edit settings.

To duplicate an existing service template

1 On the Network Preferences screen, tap the arrow V next 
to Service and select the predefined service template you 
want to duplicate.

2 Tap the Menu  icon.

3 Tap Duplicate from the Service menu.
A copy of the service template (The name of an original service 
template + Copy) is added to the drop-down list for the Service field.

To delete a service template
You can delete an existing service template.

1 On the Network Preferences screen, tap the arrow V next 
to Service and select the predefined service template you 
want to delete.

2 Tap the Menu  icon.

3 Tap Delete from the Service menu.
The Delete Service dialog box is displayed.

4 Tap OK.
The selected service template is deleted.
If you want to cancel deleting, tap Cancel.
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Changing the Network preferences
Creating Log-in Scripts
A log-in script is a series of commands that automates logging in to a network 
server, such as your corporate network or your Internet Service Provider (ISP).

You can also use non-ASCII characters or literal characters for log-in scripts.
b For details, refer to “Non-ASCII Characters for Log-in Scripts” on page 82.

Note
Depending on the type of communication adapter (sold separately), there may be cases 
when there is no need to create a log-in script.
b For details on accessories that are not supplied, refer to “Read This First (Operating 

Instructions).”

1 On the Network Preferences screen, tap Details.
The Details screen is displayed.

2 Tap Script.
The Log in Script screen is displayed.

3 Tap the arrow V next to End and select one of the following 
commands.
When the command requires additional information, a field appears to the 
right of it for you to enter the information.

Wait For Tells your CLIÉ handheld to wait for specific characters 
from the TCP/IP server before executing the next 
command.

Wait For Prompt Detects a challenge-response prompt coming from the 
server and displays the dynamically generated challenge 
value. It then enters the challenge value into your token 
card, which in turn generates a response value for you to 
enter on your CLIÉ handheld. This command takes two 
arguments, separated by a vertical bar (|) on the input 
line.

Send Transmits specific characters to the TCP/IP server to 
which you are connecting.

Send CR Transmits a carriage return or LF character to the TCP/
IP server to which you are connecting.

Send User ID Transmits the User ID information entered in the User 
ID field of the Network Preferences screen.

Continued on next page
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Changing the Network preferences
4 Repeat step 3 until the log-in script is complete.

5 Tap OK.
The Details screen is displayed.

6 Tap OK.
The Network Preferences screen is displayed.

Send Password Transmits the password entered in the Password field of 
the Network Preferences screen. If you did not enter 
a password, this command prompts you to enter one. The 
Password command is usually followed by a Send CR 
command.

Delay Tells your CLIÉ handheld to wait a specific number of 
seconds before executing the next command in the log-in 
script.

Get IP Reads an IP address and uses it as the IP address for your 
CLIÉ handheld. This command is used with SLIP 
connections.

Prompt Opens a dialog box and prompts you to enter text of 
some kind (for example, a password or a security code).

End Identifies the last line in the log-in script.
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Changing the Network preferences
Non-ASCII Characters for Log-in Scripts
The following information enables you to create a custom log-in script that 
require non-ASCII characters. It is provided for advanced users who 
understand the use and requirements of such characters in a custom log-in 
script.

Use of ^char
You may use the caret ( ̂  ) to transmit ASCII command characters. If you send 
^char, and the ASCII value of character is between @ and _, then the character 
is automatically translated to a single-byte value between 0 and 31.

For example, ^M is converted to a carriage return.

If the character is a value between A and Z, then the character sequence is 
translated to a single-byte value between 1 and 26. If the character is any other 
value, then the character sequence is not subject to any special processing. For 
example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed
You may include carriage return and line feed commands as part of the log-in 
script, when they are entered in the following format.

• <cr> : Sends or receives a carriage return

• <lf> : Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by 
a carriage return and line feed from the remote computer before executing the 
next command in the script.

Literal characters
The backslash ( \ ) character defines that the next character is transmitted as a 
literal character, and is not subject to any special processing ordinarily 
associated with that character.

Examples:

• \^ : Includes a caret as part of the string

• \< : Includes a < as part of the string

• \ \ : Includes a backslash as part of the string
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Changing the Network preferences
Using the Network preferences menus
This section describes the menu commands specific to the network 
preferences. For the menu commands that are common for the CLIÉ handheld 
applications, refer to “Common menus” on page 25.

Service menus

Options menus

New Creates a new service template.

Delete... Deletes the current service template.

Duplicate Duplicates the current service template.

View Log Displays the Network Log that lists the history of your 
Internet connection.
Tap Done to close the Network Log screen.
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Creating Graffiti® ShortCuts
You can create abbreviations (ShortCuts) for entering text with Graffiti® 
writing.
b For details on how to use Graffiti® ShortCuts, refer to “Using Shortcuts” on page 43.

1 Tap the arrow V in the upper right corner of the Preferences 
screen and select ShortCuts.
The ShortCuts Preferences screen is displayed.

2 Tap New.
The ShortCut Entry dialog box is displayed.

3 Enter the ShortCut name and an abbreviation (character 
string).

4 Tap OK.
The new ShortCut is created and displayed in the list of ShortCuts.

To Edit a ShortCut

1 Tap a ShortCut you want to edit and tap Edit.

2 Edit the ShortCut name or the abbreviation (character string) 
and tap OK.

To Delete a ShortCut

1 Tap a ShortCut you want to delete and tap Delete.
 The confirmation dialog box is displayed.

2 Tap Yes.
The selected ShortCut is deleted.
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Exchanging and 
updating data using 
the HotSync® 
operation (Other 
HotSync® operations)

This chapter explains how to perform the different methods 
of the HotSync® operations other than the local HotSync® 
operation using the USB cable and plug adapter, giving you 
broader usage of the HotSync® operations such as 
performing the HotSync® operation via a modem without 
being at your home.

Customizing the HotSync® application settings 
(Conduit)  . . . . . . . . . . . . . . . . . . . . . . . .  86

Synchronizing with external data (File Link)  . . .  88
Customizing HotSync® Manager start-up and 

HotSync® setup options  . . . . . . . . . . . . . .  89
Performing the IR HotSync® operation . . . . . . .  90
Performing the HotSync® operation via 

a modem  . . . . . . . . . . . . . . . . . . . . . . . .  93
Performing the HotSync® operation via 

a network . . . . . . . . . . . . . . . . . . . . . . . .  99
Performing the HotSync® operation via 

LAN (LANSync)  . . . . . . . . . . . . . . . . . . .  104
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Customizing the HotSync® application 
settings (Conduit)
The programs handling data of each application during the 
HotSync® operation are called “conduit.”
For each application, you can define a set of options that determine how data 
is handled during synchronization. By default, the HotSync® operation 
synchronizes all data between your CLIÉ handheld and the Palm™ Desktop for 
CLIÉ software.

In addition to the conduits for Date Book, Address Book, To Do List and 
Memo Pad, the Palm™ Desktop for CLIÉ software offers System and Install 
conduits. The System conduit backs up the system information stored on your 
CLIÉ handheld. The Install conduit installs add-on applications to your CLIÉ 
handheld. You can select them as needed.

1 Click the HotSync  icon in the Windows task tray and 
select Custom from the HotSync Manager Shortcut menu.
You can also select Custom from the HotSync menu of the Palm™ 
Desktop for CLIÉ software.
The Custom window is displayed.

2 Select the user name you are using on your CLIÉ handheld 
from the list at the top.

3 Select a conduit in the Conduit list.

Continued on next page
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Customizing the HotSync® application settings (Conduit)
4 Click Change.
The Change HotSync Action window is displayed.

5 Click to select one of the following: 
• Synchronize the files

• Desktop overwrites handheld

• handheld overwrites Desktop

• Do nothing

6 Click OK.

7 Repeat step 2 through 6 to customize conduit settings for 
other applications (or other users).

8 Click Done.
The conduit setting is changed.

Notes
• The conduit setting is applied only to the next HotSync® operation. Thereafter, the 

HotSync Actions revert to their default. To create a new default, in step 5, select the 
Set as default check box.

• To restore the default, click Default in the Custom window.
87
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Synchronizing with external data (File Link)
You can synchronize Address Book or Memo Pad data on your CLIÉ handheld 
with external files such as Address Book data on your computer (File Link). 

 HotSync® Manager stores the file data on your computer in a separate category 
of your Palm™ Desktop for CLIÉ software and your CLIÉ handheld. You can 
set the File Link feature to start synchronization only when the external file has 
been updated.

 

The compatible file formats that you can synchronize with File 
Link
• Comma delimited (*.csv)

• Memo Pad archive of the Palm™ Desktop for CLIÉ software (*.mpa)

• Address Book archive of the Palm™ Desktop for CLIÉ software (*.aba)

• Text file (*.txt)

b For details on how to set up File Link, refer to the online help of the Palm™ Desktop 
for CLIÉ software.
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Customizing HotSync® Manager start-up and 
HotSync® setup options
1 Click the HotSync  icon in the Windows task tray and 
select Setup from the HotSync Manager shortcut menu.
The Setup window is displayed.

2 Click the General tab and select a setting as needed.
If you are not sure which option to use, select Always available.
• Always available: Starts the HotSync® Manager when Windows 

starts. This allows you to perform the HotSync® operation even when 
the Palm™ Desktop for CLIÉ software is not running.

• Available only when the Palm™ Desktop is running: Starts the 
HotSync® Manager when you start the Palm™ Desktop for CLIÉ 
software.

• Manual: Starts the HotSync® Manager only when you select 
HotSync Manager from the Windows Start menu.

3 Click the Local tab and adjust the setting for the connection 
between your CLIÉ handheld and your computer as needed.
• Serial port: Specifies the computer port that is used for the HotSync® 

operation. Note that the serial port for the HotSync® operation cannot 
be shared with the port for modem.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems. You do not need to set the speed when you perform the 
HotSync® operation with the supplied USB cable and plug adapter.

4 Click the Modem tab and select the setting for the modem 
as needed.
b For details, refer to “Performing the HotSync® operation via a modem” on page 

93.

5 Click the Network tab and select the setting for the network 
as needed.

6 Click OK to finish.
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Performing the IR HotSync® operation
You can use the IR (infrared) port of your CLIÉ handheld supporting the IrDA 
(Infrared Data Association) standard to perform the IR HotSync® operation 
with a computer equipped with an IR port. The IR HotSync® operation enables 
you to perform the HotSync® operation without using the USB cable and plug 
adapter.

Prior to performing the IR HotSync® operation
Verify the following.

• Your computer is equipped with an IR port supporting the IrDA standard.

• The IR port of your computer is enabled for Windows operating system use.

• Check the port number allocated to the IR port. 
The IR port number is available in the Infrared Monitor in the Control 
Panel.

For details about the Infrared Monitor, refer to the manual of your computer or 
the Windows online help.

Preparing your computer
To perform the IR HotSync® operation, you need to allocate a virtual port for 
the IR HotSync® operation.

For Windows 2000 Professional/Windows XP

1 Click the HotSync  icon in the Windows task tray and 
select IR from the HotSync Manager shortcut menu.
The IR HotSync® operation is enabled.

For Windows 98 Second Edition/Me

1 Click the HotSync  icon in the Windows task tray and 
select Local Serial from the HotSync Manager shortcut 
menu.

Continued on next page
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Performing the IR HotSync® operation
2 Click the HotSync  icon in the Windows task tray again 
and select Setup from the HotSync Manager shortcut 
menu.
The Setup window is displayed.

3 Click the Local tab.

4 Adjust the following settings as needed.
• Serial port: Specifies a virtual port for an infrared port. If you are not 

sure of the connection port, refer to the Infrared Monitor in the 
Windows Control Panel.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems.

5 Tap OK.
The IR HotSync® operation is enabled.

Note
When performing the local HotSync® operation with the USB cable and plug adapter 
after you set for the IR HotSync® operation, you need to restore the local HotSync 
settings.
b For details, refer to “To restore the local HotSync settings” on page 92.

Continued on next page
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Performing the IR HotSync® operation
Performing the IR HotSync® operation
You can perform the IR HotSync® operation when you have prepared your 
computer setting, CLIÉ handheld setting and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip

You can also tap [HotSync] icon to display the HotSync screen.

2 Tap Local.

3 Tap the arrow V and select IR to a PC/Handheld.

4 Point the IR port of your CLIÉ handheld directly at the IR port 
of your computer.
For best results, your CLIÉ handheld and your computer should be 4 to 8 
inches (approximately 10 to 20 centimeters) apart, and the path between 
your CLIÉ handheld and your computer must be unobstructed.

5 Tap the HotSync  icon.
The HotSync® operation starts.
The message will be displayed to note that the HotSync® operation is 
complete.

To restore the local HotSync settings
When performing the local HotSync® operation with the USB cable and plug 
adapter after you set for the IR HotSync® operation, you need to restore the 
local HotSync settings.

1 Connect your CLIÉ handheld and your computer.

2 Click the HotSync  icon in the Windows task tray and 
select Local USB from the HotSync Manager shortcut 
menu.
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Performing the HotSync® operation via a 
modem
You can perform the HotSync® operation via a modem when you are away 
from your computer.

Prior to performing the HotSync® operation via a modem
Verify the following.

• A modem or terminal adapter (TA) is connected to your computer.

• The Palm™ Desktop for CLIÉ software is properly configured for use with 
the modem.

b For details, refer to “Customizing HotSync® Manager start-up and 
HotSync® setup options” on page 89.

Notes
• For the first HotSync® operation, you need to perform the local HotSync® 

operation using the USB cable and plug adapter (page 47). 
• It may take some time to complete the HotSync® operation via a modem. To 

shorten the time required to synchronize data with a modem, define the files and/
or applications you synchronize with the modem HotSync® operation in advance.

For details, refer to “Selecting the conduits for the modem HotSync® operation” on 
page 97.

Your CLIÉ handheld away 
from your computer

The HotSync® operation 
with your computer at home

     +
modem
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Performing the HotSync® operation via a modem
Preparing your computer
To perform the HotSync® operation via a modem, you need to follow the steps 
below to set your computer to receive a call from your CLIÉ handheld.

1 Verify the following.
• The modem is connected to your computer and both the modem and 

computer are turned on.

• No communication applications, such as fax or telephone software, are 
running on the COM port.

• The computer is disconnected from the Internet.

2 Click the HotSync  icon in the Windows task tray and 
select Modem from the HotSync Manager shortcut menu.

3 Click the HotSync  icon in the Windows task tray again 
and select Setup from the HotSync Manager shortcut 
menu.
The Setup window is displayed.

4 Click the Modem tab.

Continued on next page
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Performing the HotSync® operation via a modem
5 Adjust the following settings as needed.
• Serial port: Specifies the port for the modem. If you are not sure of the 

port settings, check the Modem Properties (Phone and Modem 
Options for Windows 2000 Professional/XP) in the Windows 
Control Panel.

• Speed: Determines the speed at which data is transferred. Try the As 
Fast As Possible rate first, and adjust downward if you have any 
problems.

• Modem: Specifies the modem type or manufacturer. If you are not sure 
of your modem type or if you cannot find your modem type in the list, 
select Hayes Basic.

• Setup string: Identifies the setup string for your modem automatically 
if you specify the modem type or manufacturer. If it does not work 
properly, refer to the manual of your modem.

6 Click OK.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for the modem HotSync® 
operation.

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip
You can also tap [HotSync] icon to display the HotSync screen.

2 Tap Modem.

Continued on next page
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Performing the HotSync® operation via a modem
3 Tap the arrow V beneath the HotSync  icon and select 
a modem.

4 Tap the Enter phone # field beneath the modem name.
The Phone Setup screen is displayed.

5 Adjust the following settings as needed:

1 Enter the telephone number used to access the modem connected to 
your computer.

2 Enter a dial prefix (such as “9”) to access an outside line, and tap the 
Dial prefix check box as needed. You can also enter a comma in the 
field to introduce a pause in the dialing sequence. Each comma equals 
a two second pause.

3 If the phone line you are using for your CLIÉ handheld has Call 
Waiting, select the Disable call waiting check box to avoid an 
interruption during the modem HotSync® operation.

4 If you want to use a calling card to place the call, select the Use 
calling card check box and enter the calling card number.

6 Tap OK.
The HotSync screen is displayed.
96

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)

Exchanging and updating data using the HotSync® operation (Other 
HotSync® operations)



Performing the HotSync® operation via a modem
Selecting the conduits for the modem HotSync® 
operation
You can specify files and/or applications to be synchronized to shorten the time 
required to synchronize data with a modem.

b For details, refer to “Customizing the HotSync® application settings 
(Conduit)” on page 86.

Note
If your CLIÉ handheld settings do not match those made in the Change HotSync 
Action window, the operation complies with your CLIÉ handheld settings.

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip

You can also tap [HotSync] icon to display the HotSync screen.

2 Tap the Menu  icon.

3 Tap Conduit Setup from the Options menu.
The Conduit Setup screen is displayed.

Continued on next page
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Performing the HotSync® operation via a modem
4 Tap the check boxes to clear the selection of files and 
applications that you do not want to synchronize during the 
modem HotSync® operation.
By default, all files are selected to be synchronized.
The data of applications that do not have a database (such as games) 
cannot be synchronized.

5 Tap OK.
The conduit settings are changed.

Performing the HotSync® operation via a modem
You can perform the modem HotSync® operation when you have prepared 
your computer setting, CLIÉ handheld setting and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip

You can also tap [HotSync] icon to display the HotSync screen.

2 Tap the HotSync  icon.
The HotSync® operation starts.
The message will be displayed to note that the HotSync® operation is 
complete.
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Performing the HotSync® operation via a 
network
You can perform the HotSync® operation via a network between your CLIÉ 
handheld and the computer connected to the LAN at your office when you are 
out of your office. You may not be able to perform the HotSync® operation via 
a network depending on the network environment of your office.

For details, contact the administrator of the remote access server.

Prior to performing the HotSync® operation via a network
Verify the following.

• Both your company’s network system and its remote access server support 
TCP/IP.

• You have a remote access account.

Preparing your computer

1 Click the HotSync  icon in the Windows task tray and 
select Network from the HotSync Manager shortcut menu.

2 Click the HotSync  icon in the Windows task tray again 
and select Setup from the HotSync Manager shortcut 
menu.
The Setup window is displayed.

3 Click the Network tab.

4 Click the check box next to the user name for HotSync.
Click TCP/IP Settings and assign a subnet mask as needed.
For details on a subnet mask address, refer to the manual of your operating 
system or contact the system administrator.

5 Click OK.

To perform the HotSync® operations via a network, you must have network 
administrator skills.

Continued on next page
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Performing the HotSync® operation via a network
6 Connect your CLIÉ handheld to your computer and perform 
the HotSync® operation.
The computer information (Primary PC name and Primary PC address (IP 
address)) is transferred to your CLIÉ handheld. 
When you perform the HotSync® operation via a network, your CLIÉ 
handheld identifies the computer based on the information transferred.
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Performing the HotSync® operation via a network
Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for the HotSync® 
operation via a network.

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator. 
The HotSync screen is displayed.

Tip
You can also tap [HotSync] icon to display the HotSync screen.

2 Tap Modem.

3 Tap the Menu  icon.

4 Tap Modem Sync Prefs from the Options menu.
The Modem Sync Preferences screen is displayed.

5 Tap Network.

6 Tap OK.
The HotSync screen is displayed.

Continued on next page
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Performing the HotSync® operation via a network
7 Tap Select Service beneath the HotSycn  icon.
The Network Preferences screen is displayed.

8 Tap the arrow V next to Service and select Unix or 
Windows RAS from the drop-down list.
b For details, refer to “Changing the Network preferences” on page 74 and contact 

the administrator of the remote access server.

9 Tap Done.

10 Tap the Enter phone # field.
The Phone Setup screen is displayed.

11 Adjust the each setting as needed.

12 Tap OK. 
The HotSync screen is displayed.

13 Follow “Performing the HotSync® operation via modem” on 
page 93 to select data to be synchronized.
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Performing the HotSync® operation via a network
Performing the HotSync® operation via a network
You can perform the HotSync® operation via a network when you have 
prepared your computer’s settings, CLIÉ handheld setting and Conduit Setup. 

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip

You can also tap [HotSync] icon to display the HotSync screen.

2 Tap the HotSync  icon.
The HotSync® operation starts.
The message will be displayed to note that the HotSync® operation is 
complete.
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Performing the HotSync® operation via LAN 
(LANSync)
You can perform the HotSync® operation via LAN between your computer and 
another computer connected to your CLIÉ handheld.

Prior to performing the LANSync operation
Verify the following.

• The Palm™ Desktop for CLIÉ software is installed in both computers 
connected by the LAN.

• Your CLIÉ handheld is properly connected to the USB cable and plug 
adapter.

Preparing your computer

1 Click the HotSync  icon in the Windows task tray and 
select Network from the HotSync Manager shortcut menu.

2 Click the HotSync  icon in the Windows task tray again 
and select Setup from the HotSync Manager shortcut 
menu.
The Setup dialog box is displayed.

3 Click the Network tab.

4 Click the check box next to the user name for HotSync.

5 Click OK.

To perform the LANSync, you must have network administrator skills. 
Consult a network administrator prior to setting LANSync.

LANSync via LAN

LAN

Your computer

Continued on next page
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Performing the HotSync® operation via LAN (LANSync)
6 Connect your CLIÉ handheld to your computer and perform 

the HotSync® operation.
The computer information (Primary PC name and Primary PC address (IP 
address)) is transferred to your CLIÉ handheld. 
When you perform the HotSync® operation via LAN, your CLIÉ 
handheld identifies the computer based on the information transferred.

Preparing your CLIÉ handheld
Follow the steps below to set up your CLIÉ handheld for the HotSync® 
operation via the LAN.

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator. 
The HotSync screen is displayed.

Tip

You can also tap [HotSync] icon to display the HotSync screen.

2 Tap Local.

3 Tap the Menu  icon.

4 Tap LANSync Prefs from the Options menu.
The LANSync Preferences screen is displayed.

5 Tap LANSync.

Continued on next page
• • • • • • • • • • • • • • •
105

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)

Exchanging and updating data using the HotSync® operation (Other 
HotSync® operations)



Performing the HotSync® operation via LAN (LANSync)
6 Tap OK.
The HotSync screen is displayed.

Performing the LANSync operation
You can perform the LANSync operation when you have prepared your 
computer’s settings, CLIÉ handheld setting and Conduit Setup. Turn on the 
computers and start HotSync® Manager.

Note
To perform the LANSync operation, both computers are required to be set for the 
LANSync. On each computer, click the HotSync  icon in the Windows task tray 
and make sure that Network in the HotSync Manager shortcut menu is selected. If 
not, click Network to select.

1 Rotate the Jog Dial™ navigator to select [HotSync] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The HotSync screen is displayed.

Tip
You can also tap [HotSync] icon to display the HotSync screen.

2 Tap the HotSync  icon.
The HotSync® operation starts. 
The message will be displayed to note that the HotSync® operation is 
complete.
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Using “Memory Stick®” 
media

This chapter explains how to communicate with another 
Palm OS® PDA device via “Memory Stick” media, how to 
handle “Memory Stick” media and how to use Memory Stick 
Gate for managing data on “Memory Stick” media.

Using “Memory Stick®” media . . . . . . . . . . . .108
Exchanging data via “Memory Stick” media  . .  117
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Using “Memory Stick®” media
What is “Memory Stick” media?
“Memory Stick” media is a new, compact, and portable Integrated Circuit 
recording medium with a data capacity that exceeds a floppy disk. “Memory 
Stick” media is specially designed for exchanging and sharing data among 
“Memory Stick” media compatible products, such as a digital video camera, 
etc. Because it is removable, “Memory Stick” media can also be used for 
external data storage.

“Memory Stick” media enables you to exchange data between your CLIÉ 
handheld and your computer. To exchange data via “Memory Stick” media, 
your CLIÉ handheld uses Memory Stick Gate.

Types of “Memory Stick” media
There are two types of “Memory Stick” media:

• “MagicGate Memory Stick” media, which is equipped with “MagicGate” 
copyright protection technology.

• “Memory Stick” media, which is not equipped with “MagicGate” copyright 
protection technology.

You can use both types of “Memory Stick” media with your CLIÉ handheld. 
However, make sure to use “MagicGate Memory Stick” media when you want 
to play ATRAC3 format files.

What is MagicGate?
MagicGate is the copyright protection technology that is used for “MagicGate 
Memory Stick” media or MagicGate compatible devices, such as a CLIÉ 
handheld. MagicGate certifies the device and “MagicGate Memory Stick” 
media as copyright-protection-compatible devices and encodes data to be 
played back on devices. The copyrighted data cannot be played back on a 
device that is not certificated.

Note on using “MagicGate Memory Stick” media
Do not handle copyright-protected files or directories stored on “MagicGate 
Memory Stick” media with Memory Stick Gate or Windows® Explorer, as 
the file may be disabled. To handle copyright-protected files, use a 
“MagicGate” compliant application, such as SonicStage.
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Using “Memory Stick®” media
Inserting and removing “Memory Stick” media
Insert “Memory Stick” media into the “Memory Stick” slot.

While your CLIÉ handheld is turned on, the applications in “Memory Stick” 
media will be displayed on the Application Launcher screen automatically if 
you insert “Memory Stick” media into the slot. (The feature does not work 
when a certain application is running.)

Notes
• Insert “Memory Stick” media in the right direction. If it is forced in the wrong 

direction, it may be damaged.
• Do not attempt to insert “Memory Stick” media into anywhere other than the 

“Memory Stick” slot.

To remove “Memory Stick” media
Make sure that your CLIÉ handheld is not writing to or reading data from 
“Memory Stick” media. Push “Memory Stick” media gently into the slot and 
release it. When “Memory Stick” media has popped out, pick it out from the 
slot.

The “Memory Stick” LED blinks 
in orange while your CLIÉ 
handheld is accessing “Memory 
Stick” media

Push “Memory Stick” media in Pull “Memory Stick” media out

b
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Using “Memory Stick®” media
Notes on using “Memory Stick” media
When you use “Memory Stick” media, follow the precautions below.

• Avoid touching the terminals of “Memory Stick” media or touching them 
with a metal object.

• Do not drop, bend, or expose “Memory Stick” media to external shock.

• Do not disassemble or modify “Memory Stick” media.

• Avoid getting “Memory Stick” media wet.

• Avoid using or storing “Memory Stick” media in a location subject to:

– extremely high temperature such as inside of a hot car, the outdoors 
exposed to direct sunlight, or near a heater

– direct sunlight  – high humidity

– corrosive substances – excessive dust

– magnetic fields

• When storing and carrying “Memory Stick” media, keep it in its original case 
to ensure protection of important data.

• Make a backup of important data.

• Avoid removing “Memory Stick” media from the “Memory Stick” slot while 
data is still being written or read.

• To avoid damaging or erasing data, do not

– pull out “Memory Stick” media or unplug the AC power adapter while 
formatting, or reading or writing data.

– use “Memory Stick” media in a location subject to static electricity or 
electrical interference.

• If the battery of your CLIÉ handheld is running short, the error message is 
displayed and you cannot exchange data with “Memory Stick” media. If this 
occurs, connect the AC power adapter or fully charge your CLIÉ handheld.

• Use Memory Stick Gate to format “Memory Stick” media you use in your 
CLIÉ handheld. If you format it using another application, further operation 
with your CLIÉ handheld is not guaranteed.

• If you insert “Memory Stick” media that has been formatted by another 
application, the message prompting you to format it is displayed. To use 
“Memory Stick” media in your CLIÉ handheld, follow the instructions to 
format it. Note, however, that all stored data will be erased.
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Using “Memory Stick®” media
Protecting data on “Memory Stick” media
To prevent accidental erasure of important data, you can use the write protect 
tab of “Memory Stick” media.

Write enable position
Slide the tab to the left to select the write enable position. You can read and 
write data on “Memory Stick” media.

Write protect position (LOCK)
Slide the tab to the right to select the write protect position. You can only read 
the data on “Memory Stick” media. Select the write protect position when you 
insert “Memory Stick” media containing any important data that you do not 
want to accidentally delete or overwrite.

Tip
The shape or exact location of the tab may differ from the illustration above depending 
on a type of “Memory Stick” media.

LOCK

Back side

Write Enable 
Position

Write Protect 
Position
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Using “Memory Stick®” media
Starting an application in “Memory Stick” media
You can start applications in “Memory Stick” media in the same way as the applications 
in your CLIÉ handheld. While the power of your CLIÉ handheld is on, the applications 
in “Memory Stick” media will be displayed on the Application Launcher screen 
automatically if you insert “Memory Stick” media into the slot. (The feature does not 
work when a certain application is running.)
To switch from the Application Launcher screen to the screen where the applications in 
“Memory Stick” media are displayed, follow the steps below.

Tip
You can only start applications saved in the “/PALM/Launcher” folder on “Memory 
Stick” media. 

1 Display the Application Launcher screen while “Memory 
Stick” media is inserted in your CLIÉ handheld.

2 Tap the arrow V in the upper right corner of the Application 
Launcher screen to display the category of applications.

3 Tap  Card.
The applications in “Memory Stick” media are displayed.
You can start an application in the same way that you start an application 
in your CLIÉ handheld.
If you have assigned a name to “Memory Stick” media, then  Card is 
displayed in that name.

Note
Depending on the applications, some of the features may not work. In such a case, use 
Memory Stick Gate to copy the data on your CLIÉ handheld and use the copied data.
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Using “Memory Stick®” media
Starting an application automatically when “Memory Stick” 
media is inserted

Memory Stick Autorun allows you to start a specified application 
automatically when “Memory Stick” media is inserted into your CLIÉ 
handheld. If you wish to enjoy image files using PictureGear Pocket, you 
can assign the application to be started automatically.
b For details about Memory Stick Autorun, refer to Memory Stick Autorun in the 

“CLIÉ Application Manual” installed in your computer.

Viewing information on “Memory Stick” media (Card Info)
You can view the information (such as the remaining memory space) on 
“Memory Stick” media with Card Info. 

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select [Card Info] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Card Info screen is displayed.

Tip
You can also tap [Card Info] icon to display the Card Info screen.
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Using “Memory Stick®” media
Assigning a name to “Memory Stick” media
You can assign a name to “Memory Stick” media with Card Info.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select [Card Info] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Card Info screen is displayed.

3 Tap the Menu  icon.
The menu is displayed.

4 Tap Rename Card from the Card menu.
The Rename Card dialog box is displayed.

5 Enter a new name for the inserted “Memory Stick” media and 
tap Rename.
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Using “Memory Stick®” media
Formatting “Memory Stick” media
“Memory Stick” media produced commercially are already formatted for use. 
If you need to format your “Memory Stick” media, use Memory Stick Gate 
or Card Info. The following explains how to format “Memory Stick” media 
with Memory Stick Gate.

What is formatting?
Formatting defines the recording format for your “Memory Stick” media so 
that you can access data with your CLIÉ handheld.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Rotate the Jog Dial™ navigator to select [MS Gate] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator. 
Memory Stick Gate starts.

Tip

You can also tap [MS Gate] icon to start Memory Stick Gate.

3 Tap the Menu  icon.
The Menu screen is displayed.

4 Tap Format from the Options menu.
The confirmation dialog box is displayed.

5 Tap OK.

To cancel formatting
Tap Cancel in step 5.

Continued on next page
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Using “Memory Stick®” media
Notes
• If “Memory Stick” media is reformatted, all the data stored on “Memory Stick” media 

will be erased. Make sure to check the data prior to formatting in order not to delete 
important data.

• To use “Memory Stick” media on your CLIÉ handheld, format it on your CLIÉ 
handheld. “Memory Stick” media formatted by your computer may not be read or 
written properly on your CLIÉ handheld.

• If you remove “Memory Stick” media during formatting, “Memory Stick” media will 
not be recognized. In this case, insert “Memory Stick” media again to restart 
formatting.
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Exchanging data via “Memory Stick” media
Starting Memory Stick Gate
You can copy, move or delete data between “Memory Stick” media and your 
CLIÉ handheld with Memory Stick Gate.
b For details about Memory Stick Gate, refer to Memory Stick Gate in the “CLIÉ 

Application Manual” installed in your computer.

1 Rotate the Jog Dial™ navigator to select [MS Gate] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Gate starts and the list of data on “Memory Stick” media 
is displayed.

Tips

• You can also tap [MS Gate] icon to start Memory Stick Gate.

• When Memory Stick Gate first recognizes the insertion of “Memory 
Stick” media, it automatically creates a default folder on “Memory 
Stick” media. The “default folder” stands for the standard working 
folder where Memory Stick Gate reads and writes data. A folder 
named “PALM/PROGRAMS/MSFILES” is created on inserted 
“Memory Stick” media.

Continued on next page
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Exchanging data via “Memory Stick” media
When displaying data on your CLIÉ handheld

Tap here to switch the view.
size : File size
creator : Creator ID of the file
type : File type
version : Version of the file
none : no items displayed

Tap this icon to sort in ascending or descending order.

Tap this icon to display or hide the contents.

The currently opened folder on 
“Memory Stick” media card.

Displays the files which belong 
to the same creator (ID) as one 
grouped item.

Tap this icon to switch the view 
between your CLIÉ handheld 
and “Memory Stick” media.

Lock  icon.

Tap this icon to switch the view 
between your CLIÉ handheld and 
“Memory Stick” media.

Continued on next page
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Exchanging data via “Memory Stick” media
When displaying data on “Memory Stick” media
The following icons with explanations are displayed only when you view the 
data on “Memory Stick” media. For the other icons, refer to “When displaying 
the data on your CLIÉ handheld” (page 118).

Note
When the battery power of your CLIÉ handheld is insufficient, data on “Memory Stick” 
media may not be displayed. In such a case, you need to charge your CLIÉ handheld or 
connect the AC power adapter to your CLIÉ handheld and insert “Memory Stick” media 
again.

Notes on moving or deleting data using Memory Stick Gate
In some cases when you move or delete a specific file using Memory Stick 
Gate, some CLIÉ handheld applications may not be operated properly or some 
data may be formatted. Sony is not liable for any trouble with applications or 
data that arises out of your moving or deleting a file.

Do not move or delete the following files:

• Saved Preference: Saves the final operation status or settings for various 
applications.

• Unsaved Preference: Saves the settings for various applications or user 
information on your CLIÉ handheld. If this file is deleted, you may not be 
able to synchronize correct information.

: Tap this icon to display the upper folder.

: Tap this icon to display the contents of the folder.

Tap here to display “file name” to show the file name 
with PC file extensions.

Continued on next page
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Exchanging data via “Memory Stick” media
• NetworkDB: Saves network settings. If this file is deleted, network 
connection is disabled.

• AddressDB: Saves the database for Address Book*.

• DatebookDB: Saves the database for Date Book*.

• MemoDB: Saves the database for Memo Pad*.

• MailDB**: Saves the database for Mail*.

• ToDoDB: Saves the database for To Do List*.
* These database files can be copied to “Memory Stick” media as a backup file. If you 

copy them back to your CLIÉ handheld, the identical files on your CLIÉ handheld will 
be overwritten with the information at the time of the backup. Note that any added or 
edited information on your CLIÉ handheld after the backup will be erased.

**May not be available on all models.

Copying data on your CLIÉ handheld to “Memory Stick” media
You can save data on your CLIÉ handheld to “Memory Stick” media using 
with Memory Stick Gate.

Notes
• Since copying data consumes a lot of power, you cannot use “Memory Stick” media 

when the battery power of your CLIÉ handheld is insufficient. In such a case, you need 
to connect the AC power adapter to your CLIÉ handheld.

• If your CLIÉ handheld receives IR communication while copying data, the copying 
will be disrupted. Do not allow your CLIÉ handheld to receive IR communication 
while copying data.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Tap the Home  icon.

Continued on next page
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Exchanging data via “Memory Stick” media
3 Rotate the Jog Dial™ navigator to select [MS Gate] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Gate starts and the list of data on your CLIÉ handheld is 
displayed.

Tip
You can also tap [MS Gate] icon to start Memory Stick Gate.

4 Tap data you want to copy to select. 
You can select multiple data by selecting the check boxes.

Note
Data marked with the   icon cannot be copied.

5 Tap COPY.
The Copy File dialog box is displayed.

6 Tap OK.
The data selected in step 4 is copied into the “/PALM/PROGRAMS/
MSFILES” folder on “Memory Stick” media.

Continued on next page
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Exchanging data via “Memory Stick” media
To copy all the data at once
Tap SelectAll in step 4.

To cancel the selection
• To cancel all the selections: tap ClearAll.
• To cancel only specific items: tap the selected item again.

When you want to change the folder to be copied.
Tap the arrow V in the upper right corner of the MS Gate screen and select 
MS. Select a folder to which you want to copy data when data on “Memory 
Stick” media is displayed. You can only select a folder under the 
“/PALM/PROGRAMS” or “/PALM/Launcher” folder. The other folders 
cannot be selected.

Moving data on your CLIÉ handheld to “Memory Stick” 
media
When the memory space of your CLIÉ handheld is not sufficient, you can 
move data on your CLIÉ handheld to “Memory Stick” media.

1 In step 5, tap MOVE.
The data on your CLIÉ handheld is transferred to “Memory Stick” media 
and saved.

Note
If the low battery error message is displayed while you are copying or moving data from 
your CLIÉ handheld to “Memory Stick” media, invalid files created by incomplete 
copying or moving may be left on “Memory Stick” media. 
Charge your CLIÉ handheld and try copying or moving again. If the overwrite 
confirmation dialog box is displayed, tap Yes or Yes to all.
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Copying data on “Memory Stick” media to your CLIÉ handheld
You can copy the data saved in “Memory Stick” media to your CLIÉ handheld 
using with Memory Stick Gate. Prior to copying data, make sure that the 
memory space of your CLIÉ handheld is sufficient.

Tip

You can also copy data into another folder on “Memory Stick” media.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Tap the Home   icon.

3 Rotate the Jog Dial™ navigator to select [MS Gate] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Gate starts and the list of data on your CLIÉ handheld is 
displayed.

Tip
You can also tap [MS Gate] icon to start Memory Stick Gate.

4 Press the Jog Dial™ navigator again.
The data in the “/PALM/PROGRAMS/MSFILES” folder on “Memory 
Stick” media is displayed.

Tip
You can also tap the arrow V in the upper right corner of the MS Gate screen and 
select MS.

Continued on next page
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Exchanging data via “Memory Stick” media
5 Tap data you want to copy to select.
You can select multiple data by selecting the check boxes.

6 Tap COPY.
The Copy File dialog box is displayed.

7 Tap OK.
The data selected in step 5 is copied to your CLIÉ handheld.

To copy all the data at once
Tap SelectAll in step 5.

To cancel the selection
• To cancel all the selections: tap ClearAll.
• To cancel only specific items: tap the selected item again.

To change the folder to be copied
Tap  or  to select a folder you want to copy. The displays of the folders 
are changed. You can specify the folder to be copied. You can only select a 
folder under the “/PALM/PROGRAMS” or “/PALM/Launcher” folder. 
The other folders cannot be selected.

Moving data on “Memory Stick” media to your CLIÉ 
handheld
You can move the data from “Memory Stick” media to your CLIÉ handheld.

1 In step 6, tap MOVE.
The data on “Memory Stick” media is transferred to your CLIÉ handheld 
and saved.

Note
Some data copied from “Memory Stick” media to your CLIÉ handheld may not be 
synchronized during the HotSync® operation.
Using “Memory Stick®” media 124

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Exchanging data via “Memory Stick” media
Deleting data on “Memory Stick” media
You can delete the data from “Memory Stick” media with Memory Stick 
Gate.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Tap the Home  icon.

3 Rotate the Jog Dial™ navigator to select [MS Gate] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Gate starts and the list of data on your CLIÉ handheld is 
displayed. 

Tip
You can also tap [MS Gate] icon to start Memory Stick Gate.

4 Press the Jog Dial™ navigator again.
The data in the “/PALM/PROGRAMS/MSFILES” folder on “Memory 
Stick” media is displayed.

Tip
You can also tap the arrow V in the upper right corner of the MS Gate screen and 
select MS.

5 Tap data you want to delete to select.

6 Tap DELETE.
The Delete File dialog box is displayed. Continued on next page
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7 Tap OK.
The data selected in step 5 is deleted from “Memory Stick” media.

To delete all the data at once
Tap SelectAll in step 5.

To cancel the selection
• To cancel all the selections: tap ClearAll.
• To cancel only specific items: tap the selected item again.

To change the folder to be deleted
Tap the arrow V in the upper right corner of the MS Gate screen and select 
MS. Select a folder you want to delete when the data on “Memory Stick” media 
is displayed. You can only select a folder under the “/PALM/PROGRAMS” 
or “/PALM/Launcher” folder. The other folders cannot be selected.
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Exchanging data without using Memory Stick Gate
You can exchange the data between “Memory Stick” media and your CLIÉ 
handheld from the menu of the Application Launcher screen.

However, problems may occur depending on the application. Note the 
following.

• You can copy only applications. Related files to applications cannot be 
copied.

• Data stored on “Memory Stick” media (such as image files) cannot be 
displayed.

1 Insert “Memory Stick” media into the “Memory Stick” slot of 
your CLIÉ handheld.

2 Tap the Menu  icon on the Application Launcher screen.
The menu is displayed.

3 Tap Copy from the App menu.
The Copy screen is displayed.

4 Tap the arrow V next to Copy To and select handheld or 
Card. 

From is automatically selected when you select Copy To.

5 Tap an application you want to copy.

6 Tap Copy.
The selected application is copied to CLIÉ handheld or “Memory Stick” 
media.

7 Tap Done.
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Notes on starting applications in “Memory Stick” media
You can start an application (files with extensions such as .prc,.pdb) in 
“Memory Stick” media. However, note the following prior to starting the 
application.

• You can start applications in “Memory Stick” media, but related files such 
as image files or movie files may not be opened (played back). 

• When you cannot open the data of an application that is installed in “Memory 
Stick” media, move the data to your CLIÉ handheld or delete the data using 
with Memory Stick Gate.

Tip
When the data is installed in “Memory Stick” media with the HotSync® operation, the 
data files are stored in the /PALM/Launcher folder.
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Beaming

This chapter explains how to communicate with another 
Palm OS® PDA device via the infrared communications port.

Beaming between your Sony CLIÉ™ handheld and 
another Palm OS® PDA  . . . . . . . . . . . . .  130
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Beaming between your Sony CLIÉ™ handheld 
and another Palm OS® PDA
What you can do with beaming
Your CLIÉ handheld is equipped with an IR (infrared) port that enables you to 
exchange data with another Palm OS® PDA device that has an IR port. The IR 
port is located at the top of your CLIÉ handheld behind the small plastic shield.

You can beam the following information between your CLIÉ handheld and 
another Palm OS® PDA device that has an IR port:

• The data of Address Book, Date Book, To Do List or Memo Pad.

• All data in the category currently displayed in Address Book, To Do List 
or Memo Pad.

• Address Book data that you designate as your business card.

• Add-on applications installed in the memory.

Notes
• Some applications are protected from copying and cannot be beamed. Applications 

marked with the  icon cannot be copied.
• If you charge your CLIÉ handheld when the battery power is empty, you may not be 

able to exchange data via beaming. In such a case, perform a soft reset and try beaming 
again.
b For details on how to perform a soft reset, refer to “Basic operations of your Sony 

CLIÉ™ handheld: Restarting your Sony CLIÉ™ handheld” in “Read This First 
(Operation Instructions).”

IR Port
Beaming 130

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Beaming between your Sony CLIÉ™ handheld and another Palm OS® PDA
Sending data via beaming
You can beam data on your CLIÉ handheld to another Palm OS PDA device 
that has an IR port.

1 Select the data, category or business card you want to 
beam.

2 Tap the Menu  icon.

3 Tap one of the following from the Record menu.
• The Beam command for an individual record

• In Address Book only: Beam Business Card
• Beam Category

4 When the Beam dialog box is displayed, point the IR port of 
your CLIÉ handheld directly at the IR port of another Palm 
OS PDA device.

For best results, your CLIÉ handheld and another Palm OS PDA device 
should be 4 to 8 inches (approximately 10 to 20 centimeters) apart, and the 
path between your CLIÉ handheld and another Palm OS PDA device must 
be unobstructed. The optimum distance for beaming may vary depending 
on devices

5 Wait for a while until the Beam dialog box displays that the 
transfer is complete.
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Beaming between your Sony CLIÉ™ handheld and another Palm OS® PDA
Sending applications via beaming

1 Tap the Menu  icon on the Application Launcher screen.

2 Tap Beam from the App menu.
The Beam screen is displayed.

3 Tap the arrow V next to Beam From and select Handheld.
Select Handheld when the application you want to send is saved on your 
CLIÉ handheld or  card when it is saved in the “/PALM/Launcher” 
folder on “Memory Stick” media.  

4 Tap an application you want to send on the Beam screen.
Some applications are protected from copying and cannot be beamed. 
Applications marked with the  icon cannot be copied.

5 Tap Beam.
The message will be displayed when the beaming is complete.
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Beaming between your Sony CLIÉ™ handheld and another Palm OS® PDA
Receiving data via beaming

1 Turn on your CLIÉ handheld and point the IR port of your 
CLIÉ handheld directly to the IR port of another Palm OS 
PDA device. 
The Beam dialog box is displayed and beaming of the data starts.

2 Select a category where you want to save the received data. 
You can also create a new category to save the data to, or save it in the 
Unfiled category.

3 Tap Yes.
The data is saved.

Note
When Beam Receive in the Preferences screen is set to Off, you cannot receive data 
using the beaming feature. Prior to beaming data, set Beam Receive to On.

Tips on beaming
• Data or applications received via beaming are saved in the Unfiled category.

• You can press the Address Book  button for about two seconds to beam 
your business card.

• You can use Graffiti® writing to beam data (  then  , or  and then 
tap ).
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Using the calculator 
and finding records

This chapter explains how to efficiently search for records 
and how to use the calculator.

Using Calculator (Calc)  . . . . . . . . . . . . . . . .  135
Finding records . . . . . . . . . . . . . . . . . . . . . .  138
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Using Calculator (Calc)
Calculating with Calculator
You can perform basic calculations with Calculator. Moreover, you can save 
the numbers in the calculator memory and recall it from the memory.

1 Rotate the Jog Dial™ navigator to select [Calc] icon on the 
Application Launcher screen and press the Jog Dial™ 
navigator.
Calculator starts.

Tip
You can also tap [Calc] icon to start Calculator.

2 Perform calculations.
To use Calculator, tap the numbers or symbols on the screen with the 
stylus.
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Using Calculator (Calc)
The functions of the Calculator buttons
Calculator has several buttons to help you perform calculations.

CE Clears the last number you entered. 
Use this button if you make a mistake while entering 
numbers. This button enables you to re-enter the number 
without starting the calculation again.

C Clears the entire calculation and enables you to start a 
new calculation.

+/- Toggles the current number between positive and 
negative. If you want to enter a negative number, enter 
the number and then tap the +/- button.

M+ Adds the current number to the total value in the 
memory. Each number you enter with the M+ button is 
added to the total value stored in the memory. The 
number to be added can be either a calculated value or 
the number you entered by pressing the number buttons. 
Pressing this button has no effect on the current 
calculation (or series of calculations); it merely places 
the value into the memory until it is recalled.

MR Recalls the total value stored in the memory and inserts 
it in the current calculation.

MC Clears any value that is stored in the Calculator memory.

Calculates the square root of the entered number. 
Tap the button after entering the number.
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Using Calculator (Calc)
Using the Calculator menus

Edit menus

* The function is available only when the JogAssist function is set.

Options menus

Copy, Paste Copies values from Calculator and pastes it into 
another application. You can also paste numeric values 
you copied from another application such as Memo 
Pad into Calculator.

Power Off* Turns off your CLIÉ handheld.

Find* Displays the Find dialog box (page 138).

Recent Calculations You can review the last series of calculations. This is 
useful when you want to view the calculations later.

About Calculator Shows the version information for Calculator.
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Finding records
You can find information by entering text with the Find function or searching 
for a phone number using the Phone Lookup function. These two functions are 
available for all the basic CLIÉ handheld applications. 

Each application offers ways to find information: 

• Date book, To Do List and Memo Pad: You can find a phone number 
using the Phone Lookup function and you can also paste the phone number 
into another application data.  

• Address Book: When you enter the first letter of a name you are looking 
for in the Look Up line at the bottom of the Address list screen, it 
immediately finds the name and scrolls to that name.

Using the Find function
You can find records on your CLIÉ handheld by entering the whole word or the 
first few letters. The search results are displayed by application. This feature is 
useful if you do not remember which application you used to create a record 
you search for.

Note
The Find function is not compatible with some application data.

1 Tap the Find  icon.
The Find dialog box is displayed.

2 Enter the text you want to find.
You can enter letters, symbols or numbers.

Continued on next page
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3 Tap OK.
The Find function starts to search and displays the list of search results.
The attached comments added to each data can also be searched for.

4 Tap data you want to view in the list of search result.
The application associated with the data automatically starts to open the 
data.

To stop searching
Tap Stop and Cancel.
To resume the search, tap Find More.

Note
The Find function is not case sensitive; searching for “sony” also finds “Sony.”

Tip
Select text in an application prior to tapping the Find icon to automatically place the text 
in the Find dialog box.

Using the Phone Lookup function
You can find a telephone number from the Address list screen and insert the 
phone number into another application record, such as inserting a phone 
number from Address Book into the record displayed in Memo Pad.

1 Display a record in which you want to insert a phone number.
The record can be in Date Book, To Do List or Memo Pad.

2 Tap the Menu  icon.
The menu is displayed.

Continued on next page
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3 Tap Phone Lookup from the Options menu.
The Lookup screen is displayed.

4 Tap a phone number you want to insert.

Tip
To find a phone number quickly, enter the first few letters of a name you are looking for 
in the Look Up line at the bottom of the screen.

5 Tap Add.
The Lookup screen closes and the name and phone number are inserted 
to the record you displayed in step 1.

To activate the Phone Lookup function with Graffiti® 
writing
Draw the Graffiti® stroke   to activate the Phone Lookup function.

Phone Lookup using text
Enter the first letter of a name and then draw the Graffiti® stroke  . The 
Phone Lookup function finds the name and phone number and inserts them in 
the record you display. If multiple records are found or the record is not found, 
the Lookup screen is displayed. You can also drag a text and then draw the 
Graffiti® stroke   to activate the same function.
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Backing up your Sony 
CLIÉ™ handheld data

This chapter explains how to back up data on your CLIÉ 
handheld.

Backing up your Sony CLIÉ™ handheld data  . .  142
Backing up data to your computer via 
the HotSync® operation. . . . . . . . . . . . . . . . .  142
Backing up data to “Memory Stick” media 
using Memory Stick Backup  . . . . . . . . . . . . .  143
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Backing up your Sony CLIÉ™ handheld data
You can make a backup of your CLIÉ handheld data by one of the following 
methods:

• Back up data to your computer via the HotSync® operation.

• Back up data to “Memory Stick” media using Memory Stick Backup.

Backing up data to your computer via the HotSync® operation
By default, you can back up the following data to your computer via the 
HotSync® operation:

• Memo Pad data files

• Address Book data files

• To Do List data files

• Date Book data files

• Mail data files*

• Preferences data files

• Application files that have been installed using the HotSync® operation

• User information files when the HotSync® operation is performed

When the HotSync® operation is performed, the backup data is compared with 
the data on your computer, and the newer one becomes effective. If you 
perform a hard reset, all data stored on your CLIÉ handheld are erased and the 
initial status will be restored. In such a case, you can restore the backup data 
from your computer that was created via the previous HotSync® operation.
*May not be available on all models.

Notes
• Some applications installed later or data created after installing applications cannot be 

backed up via the HotSync® operation, such as applications or data transferred from 
“Memory Stick” media or beamed. You need to back up with “Memory Stick” media 
(page 143).

• If you customize settings in the Change HotSync Action window, you may not be 
able to back up a file. You cannot back up an application or restore its data if an option 
other than “Synchronize the files” is selected. 
b For details, refer to “Customizing the HotSync® application settings (Conduit)” on 

page 86.
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Backing up your Sony CLIÉ™ handheld data
Backing up data to “Memory Stick” media using Memory Stick 
Backup

With Memory Stick Backup, you can back up the following applications 
and data to “Memory Stick” media.

• Memo Pad data files

• Address Book data files

• To Do List data files

• Date Book data files

• Mail data files*

• Preferences data files

• Add-on application files
*May not be available on all models.

1 Insert “Memory Stick” media into your CLIÉ handheld.

2 Tap the Home  icon.

3 Rotate the Jog Dial™ navigator to select [MS Backup] icon 
on the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Backup starts.

4 Tap the Backup  icon.
The Backup All Files dialog box is displayed.

5 Tap OK.
The Backup Progress screen is displayed.
General information of the backup (date, size and number of database) is 
displayed in the list.

Notes
• When you back up data on your CLIÉ handheld to “Memory Stick” media, the 

size of the backup data may become larger than the size of original data. 
• Do not back up when free memory space in your CLIÉ handheld is insufficient. 

The backup data may not be restored properly.

Continued on next page
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Backing up your Sony CLIÉ™ handheld data
Tips
• The backup will be finished within a few minutes.
• In step 4, you can also select an existing file from the backup list, then tap 

Backup to overwrite it.
• The data size displayed in the list shows the size of the applications and data 

stored on your CLIÉ handheld.
• “Number of database” shows the number of applications and data that have been 

backed up.
• If a backup file on “Memory Stick” media has been updated using Memory 

Stick Gate, the file may not be backed up or restored properly.

To delete a backup file from “Memory Stick” media
 Select backup data you want to delete in the backup list, and tap Delete. 

Restoring backup data and applications to your CLIÉ 
handheld

Notes
• When you restore backup data and applications to your CLIÉ handheld, the data 

currently saved on your CLIÉ handheld will be overwritten by the backup data. Any 
data created or edited after you saved the backup will be deleted.

• You can only restore data to your CLIÉ handheld from where you took that backup.

1 Perform a hard reset on your CLIÉ handheld.
b For details on a hard reset, refer to “Basic operations of your Sony CLIÉ™ 

handheld: Restarting your Sony CLIÉ handheld” in “Read This First (Operating 
Instructions).”

2 Insert “Memory Stick” media containing the backup files into 
your CLIÉ handheld.

3 Tap the Home  icon.

4 Rotate the Jog Dial™ navigator to select [MS Backup] icon 
on the Application Launcher screen and press the Jog Dial™ 
navigator.
Memory Stick Backup starts and the backup list is displayed.

5 Tap backup data you want to restore from the list.

Continued on next page
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Backing up your Sony CLIÉ™ handheld data
6 Tap the Restore  icon.
The Restore All Files dialog box is displayed.

7 Tap OK. 
The Confirm Restore dialog box is displayed.

8 Tap OK.
The Restore Process screen is displayed.
If there is initial data automatically created by each application when you 
perform a hard reset or if you created or updated data after a hard reset, the 
Restore File dialog box is displayed. Tap Yes to overwrite, tap Yes To 
All to overwrite all data, or tap No to leave the data.
When the backup data is restored, your CLIÉ handheld shuts down and 
restarts automatically.

Tip
To select backup data by file, use the Copy function in Memory Stick Gate. 
b For details on how to use Memory Stick Gate, refer to page 117.
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Protecting your data 
with a password

This chapter explains how to manage your personal details 
using the various applications of your CLIÉ handheld and 
how to protect your data with a password.

Entering personal information . . . . . . . . . . . .  147
When you have already assigned a password 
to protect your data . . . . . . . . . . . . . . . . . . . . 148

Locking your Sony CLIÉ™ handheld with a password 
(Data protection) . . . . . . . . . . . . . . . . . . .149
Turning off your CLIÉ handheld after 
locking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Setting your CLIÉ handheld to be locked 
automatically . . . . . . . . . . . . . . . . . . . . . . . . . 151

Protecting data . . . . . . . . . . . . . . . . . . . . . .  152
Assigning a password . . . . . . . . . . . . . . . . . .  152
Changing or deleting a password  . . . . . . . . .  153
Hiding or masking private data  . . . . . . . . . . .  154
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Entering personal information
You can enter personal information such as name, company name and 
telephone number on your CLIÉ handheld. If you assign a password, the 
personal information will be displayed when your CLIÉ handheld is turned on 
next time.

1 Rotate the Jog Dial™ navigator to select [Prefs] icon on the 
Application Launcher screen and press the Jog Dial™ 
navigator.
The Preferences screen is displayed.

Tip
You can also tap [Prefs] icon to display the Preferences screen.

2 Tap the arrow V in the upper right corner of the Preferences 
screen and select Owner.
The Owner preferences screen is displayed.

3 Enter your personal information.
When character strings that are entered do not fit within the screen, the 
scroll bar is displayed on the right side of the screen.
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Entering personal information
If you have already assigned a password to protect your 
data
As the information is already protected, personal information cannot be entered 
or edited. Follow the steps below to unlock the protection to enter or edit 
personal information.

1 Rotate the Jog Dial™ navigator to select [Prefs] icon on the 
Application Launcher screen and press the Jog Dial™ 
navigator.
The Preferences screen is displayed.

Tip
You can also tap [Prefs] icon to display the Preferences screen.

2 Tap the arrow V in the upper right corner of the Preferences 
screen and select Owner.
The Owner preferences screen is displayed.

3 Tap Unlock.
The Unlock Message dialog box is displayed.

4 Enter the assigned password and tap OK.
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Locking your Sony CLIÉ™ handheld with a 
password (Data protection)
You can lock your CLIÉ handheld by assigning a password. Your CLIÉ 
handheld requires the user to enter the password when it is turned on.

Note
To start your CLIÉ handheld when it is locked, you must enter the correct password. If 
you forget the password, you need to perform a hard reset. However, performing a hard 
reset deletes all the data on your CLIÉ handheld. (By performing the HotSync® 
operation, you can restore the backup data from your computer.)
b For details on how to reset your CLIÉ handheld, refer to “Basic operations of your 

Sony CLIÉ™ handheld: Restarting your Sony CLIÉ handheld” in “Read This First 
(Operating Instructions).” 

Turning off your CLIÉ handheld after locking
This feature locks and turns off your CLIÉ handheld. To start your CLIÉ 
handheld, it is necessary to enter the correct password.

1 Perform the HotSync® operation between your CLIÉ 
handheld and your computer to make backup data on your 
CLIÉ handheld to your computer.
b For details about the HotSync® feature, refer to “Backing up data to your 

computer via the HotSync® operation” on page 142.

2 Follow “Assigning a password” on page 152 to assign a 
password.

Continued on next page
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Locking your Sony CLIÉ™ handheld with a password (Data protection)
3 Rotate the Jog Dial™ navigator to select [Security] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Security screen is displayed.

Tip
You can also tap [Security] icon to display the Security screen.

4 Tap Lock & Turn Off.
The System Lockout screen is displayed.

5 Tap Off & Lock.
Your CLIÉ handheld turns off and locks.
To start your CLIÉ handheld, you must enter the correct password.
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Locking your Sony CLIÉ™ handheld with a password (Data protection)
Setting your CLIÉ handheld to be locked automatically
You can set a time for your CLIÉ handheld to be locked automatically.

1 Follow step 1 through 3 in “Turn off your CLIÉ handheld after 
locking” on page 149.
The Security screen is displayed.

2 Tap Never.
The Password dialog box is displayed.

3 Enter the password and tap OK.
The Lock handheld screen is displayed.

4 Tap one of the following from the list on the Lock handheld 
screen.
• Never: Your CLIÉ handheld is not locked automatically.

• On power off: Your CLIÉ handheld is locked when it is turned off.

• At a preset time: Set a time for your CLIÉ handheld to be locked 
automatically.

• After a preset delay: Set a time for your CLIÉ handheld to be locked 
automatically if it is inactive for a preset time.

5 Tap OK.
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Protecting data
You can protect your data from unauthorized users by assigning a password. 
Additionally, you can create private data which will not be displayed even if a 
password is entered.

Assigning a password
You can assign a password to protect your private data or to lock your CLIÉ 
handheld.

1 Rotate the Jog Dial™ navigator to select [Security] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Security screen is displayed.

Tip
You can also tap [Security] icon to display the Security screen.

2 Tap -Unassigned-.
The Password dialog box is displayed.

3 Enter a password.

4 Tap OK.
The Password dialog box for confirmation is displayed.

5 Enter the password again to verify it and tap OK.
Your password is assigned and -Assigned- is displayed in step 2.

Continued on next page
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Protecting data
Tip
In step 3, you can enter a hint to remember your password. The hint will be 
displayed to remind you of the correct password if you enter an incorrect password.

Changing or deleting a password
You can change or delete the assigned password.

1 Rotate the Jog Dial™ navigator to select [Security] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Security screen is displayed.

Tip
You can also tap [Security] icon to display the Security screen.

2 Tap -Assigned-.
The Password dialog box is displayed.

3 Enter the current password and tap OK.
The Password dialog box is displayed.

4 Enter a new password and tap OK.
To delete the password, tap Unassign.

If you forget your password
If you forget your password, you can delete it forcibly. However, note that 
deleting the password forcibly also deletes all your private data. (If you 
perform the HotSync® operation to synchronize with your computer, you can 
restore your private data that has been backed up.)

1 In step 2, tap Lost Password.
The Delete Password dialog box is displayed.

2 Tap Yes.
Your password and private data are deleted.
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Protecting data
Hiding or masking private data
You can set to hide or mask your private data on applications such as Address 
Book or Memo Pad. To view the private data, you need to enter the 
password. Although the data is invisible, it is saved.

1 Rotate the Jog Dial™ navigator to select [Security] icon on 
the Application Launcher screen and press the Jog Dial™ 
navigator.
The Security screen is displayed.

Tip
You can also tap [Security] icon to display the Security screen.

2 Tap the arrow V beneath Current Privacy to select Mask 
Records or Hide Records. 
The Mask Records or Hide Records dialog box is displayed.

3 Tap OK.
The private data becomes invisible.

When you select Hide Records When you select Mask Records
Protecting your data with a password 154

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Enhancing features 
with add-on 
applications

This chapter explains how to enhance features of your CLIÉ 
handheld by installing applications from your computer, 
Internet and “Memory Stick” media.

Enhancing features with add-on 
applications  . . . . . . . . . . . . . . . . . . . . .  156

Installing add-on applications . . . . . . . . . . . .  157
Installing add-on applications from 
your computer . . . . . . . . . . . . . . . . . . . . . . . . 157
Installing add-on applications to 
“Memory Stick” media. . . . . . . . . . . . . . . . . .  159
Installing add-on applications from 
the Internet  . . . . . . . . . . . . . . . . . . . . . . . . . .  159
Deleting the installed add-on applications . . .  160
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Enhancing features with add-on applications
You can enhance the features of your CLIÉ handheld by installing applications, 
such as games or other software, that run on Palm OS (Add-on applications). 
For the latest information on the applications that can be used in your CLIÉ 
handheld, refer to the CLIÉ website.

Note
As all the add-on applications installed in your CLIÉ handheld are temporarily saved in 
the memory, all the add-on applications will be deleted when a hard reset is performed. 
In such a case, you need to reinstall them in your CLIÉ handheld.

To install the applications from the supplied CD-ROM, refer to “Using 
applications” in “Read This First (Operating Instructions).”
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Installing add-on applications
Installing add-on applications from your computer
You can install the applications in your computer to your CLIÉ handheld or 
“Memory Stick” media inserted in your CLIÉ handheld.

1 Double-click [Palm Desktop for CLIÉ] icon on your Windows 
desktop.
You can also click Start, then select Programs (All Programs in 
Windows XP), Sony Handheld and Palm Desktop for CLIÉ in 
Windows.
The Palm™ Desktop for CLIÉ software starts.

2 Click Install.
The Install Tool window is displayed.

3 Select a user from the User selector.

4 Click Add.
The Open dialog box is displayed.
The supplied applications are saved in the folder: Program Files/Sony 
Handheld/Add-on/PEG-XXX (the model you use).

For details on how to install the applications that are supplied with your 
CLIÉ handheld, refer to “Using applications” in “Read This First (Operating 
Instructions).”

Continued on next page
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Installing add-on applications
5 Select applications you want to install from the folder and 
click Open.
The list of the selected applications is displayed on the Install Tool 
window.
Click Remove to delete applications that you do not want to install. The 
applications will be deleted from the list, but not from your computer.

6 Click Done.
The confirmation dialog box is displayed.

7 Click OK.

8 Perform the local HotSync® operation. 
The applications selected in step 5 are installed in your CLIÉ handheld or 
“Memory Stick” media.
b For details about the local HotSync® operation, refer to “Performing the 

HotSync® operation” on page 47.

Displaying the Install Tool screen directly from the Start 
menu in Windows
To display the Install Tool window, click Start, then select Programs (All 
Programs in Windows XP), Sony Handheld and Install Tool. You can 
also double-click files that can be installed such as .prc or .pdb format files.
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Installing add-on applications
Installing add-on applications to “Memory Stick” media
Add-on applications can be installed in “Memory Stick” media by the 
following methods.

• Install an application directly in “Memory Stick” media from your computer 
using Memory Stick Import/Memory Stick Export.

• After step 5 in “Installing add-on applications from your computer,” click 
Change installation Destination. Select the application and click either 
>> or << to specify “Memory Stick” media for the location to save the 
application.

Notes on installing add-on applications in “Memory Stick” 
media:
In some applications, related files, such as image files or movie files, cannot be 
opened (played back). 

In the procedure mentioned above, when you select “Memory Stick” media and 
install the data or application in “Memory Stick” media by the HotSync® 
operation, they are installed in the /PALM/Launcher folder. Some Sony 
applications only support data in the /PALM/PROGRAMS folder. The data 
installed in the /PALM/Launcher folder on “Memory Stick” media by the 
HotSync® operation cannot be displayed for those applications.

In such a case, delete the data or applications from “Memory Stick” media 
using with Memory Stick Gate.

Installing add-on applications from the Internet
You can download applications from the CLIÉ website below and install them 
in your CLIÉ handheld.

For customers in the U.S.A. and Canada

http://www.sony.com/clie/

For customers in Australia, Hong Kong, Malaysia, Mexico, New Zealand, 
Singapore, Taiwan and Thailand.

http://vaio-online.sony.com/clie/

1 Download applications you want to install in your computer 
from the Internet.
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Installing add-on applications
2 Follow the instructions including readme files to install the 
downloaded applications in your CLIÉ handheld.
If there are no specific instructions, double-click the downloaded PRC 
format (.prc) file and perform step 6 through 8 in “Installing add-on 
applications from your computer” on page 157.

Deleting the installed add-on applications

Tip
You can only delete the applications that you installed by yourself. Default applications, 
such as Address Book or Memo Pad, cannot be deleted.

1 Tap the Home  icon.

2 Tap the Menu  icon.
 The menu is displayed. 

3 Tap Delete from the App menu.
The Delete screen is displayed. 

Continued on next page
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Installing add-on applications
4 Tap the arrow V next to Delete From to select Handheld or 
 Card.

5 Tap an application you want to delete and tap Delete.
The Delete Application dialog box is displayed.

6 Tap Yes.
The application selected in step 5 is deleted.
To cancel deleting, tap No.

7 Tap Done.
The Application Launcher screen is displayed.
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Transferring data with 
another Sony CLIÉ™ 
handheld

This chapter explains how to transfer data from your CLIÉ 
handheld to another CLIÉ handheld.

Transferring data with another Sony CLIÉ™ 
handheld  . . . . . . . . . . . . . . . . . . . . . . . .163
Transferring data using the Palm™ Desktop for 
CLIÉ software  . . . . . . . . . . . . . . . . . . . . . . . .  163
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Transferring data with another Sony CLIÉ™ 
handheld
Notes
• You cannot transfer data from another CLIÉ handheld with Memory Stick Backup.
• You cannot transfer applications that you installed. You need to reinstall them in your 

CLIÉ handheld. 
• Some third-party applications may operate only on your old CLIÉ handheld. 
For details, contact the application manufacturer.

Transferring data using the Palm™ Desktop for CLIÉ software
For data of the basic Palm OS® applications such as Address Book, Memo 
Pad, To Do List and Date Book, you can use the Palm™ Desktop for CLIÉ 
software to transfer data from your old CLIÉ handheld to your new CLIÉ 
handheld by exporting and importing data.

Before you start transferring data, you need to perform the HotSync® operation 
between your previous CLIÉ handheld and the Palm™ Desktop for CLIÉ 
software for your new CLIÉ handheld, using a new user name you have never 
used. After performing the HotSync® operation following “Exchanging and 
updating data using the HotSync® operation” on page 45, follow the steps 
below.

1 Double-click [Palm Desktop for CLIÉ] icon on your Windows 
desktop.
You can also click Start, then select Programs (All Programs in 
Windows XP), Sony Handheld and Palm Desktop for CLIÉ in 
Windows.
The Palm™ Desktop for CLIÉ software starts.

2 Click the user name of your previous CLIÉ handheld from the 
User selector in the upper right corner of the screen.

3 Click the icon of an application you want to copy.

4 Click Export from the File menu.

5 Enter the file name and click Export.
The data on your old CLIÉ handheld is exported. 
Change the location to save the application as needed.

Continued on next page
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Transferring data with another Sony CLIÉ™ handheld 163

Sony Personal Entertainment Organizer  A-BGK-100-11 (1)



Transferring data with another Sony CLIÉ™ handheld
6 Repeat step 3 through 5 to export data of other applications.

7 Click the user name of your new CLIÉ handheld from the 
User selector in the upper right corner of the screen.

Tip
If you have never performed the HotSync® operation with your new CLIÉ 
handheld, click Users from the Tools menu. Click New in the Users dialog box 
and enter a new user name. 
Then select the user name you just entered.

8 Click Import from the File menu.

9 Select the files you have exported in step 3 through 6 and 
click Import.

10 Perform the HotSync® operation.
The data exported from your old CLIÉ handheld is copied onto your new 
CLIÉ handheld.

Do not perform the HotSync® operation with the same 
user name in other CLIÉ handhelds
If the HotSync® operation between your new CLIÉ handheld and the Palm™ 
Desktop for CLIÉ software for your old CLIÉ handheld is performed with the 
user name that has been used, the setting information that is specific to the old 
CLIÉ handheld will be also transferred with the data and some problems may 
arise. If you try performing the HotSync® operation in the same way with your 
old CLIÉ handheld, problems may also arise. Do not transfer data with the 
same user name.
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Transferring data with another Sony CLIÉ™ handheld
The screen to select the user name is displayed when 
performing the HotSync® operation with your CLIÉ 
handheld
Enter a name that is different from the user name of your old CLIÉ handheld. 
If the same user name is used, the Palm™ Desktop for CLIÉ software will not 
recognize your CLIÉ handheld properly and the data of the respective CLIÉ 
handhelds will be mixed or deleted.

Moreover, if you copy Unsaved Preference from another CLIÉ handheld to 
your CLIÉ handheld, you will not be able to manage your CLIÉ handheld with 
a new user name since the user name is also copied.

Note on performing the HotSync® operation with another 
CLIÉ handheld
When using another CLIÉ handheld, install (overwrite) Palm™ Desktop for 
CLIÉ software that is supplied with your new CLIÉ handheld without deleting 
the Palm™ Desktop for CLIÉ software for your old CLIÉ handheld, from your 
computer.

The new Palm™ Desktop for CLIÉ software will be installed after uninstalling 
the old software except for the necessary features for your new CLIÉ handheld.
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For the latest information on support 
and accessories, 

check our official Sony CLIÉ website

For customers in the U.S.A. and Canada

http://www.sony.com/clie/

For customers in Australia, Hong Kong, Malaysia, 
Mexico, New Zealand, Singapore, Taiwan and Thailand

http://vaio-online.sony.com/clie/
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